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I.認識 Unity 遊戲開發引擎與
軟體安裝、授權 

Unity 是位居世界領先地位的遊戲創作引擎，並持續引入新功能，以協助開
發團隊的⼈員建⽴共同的開發體驗，使美術⼈員可以直接為遊戲建⽴劇情動
畫內容，企劃⼈員能夠花更多的時間在編輯遊戲內容，⽽不需要與技術⼈員
排隊進⾏開發內容。 

1.Unity 遊戲開發引擎的特點 
1.1. 豐富且可擴充的編輯器 

Unity 編輯器是藝術家、設計師、開發者以及其他團隊成員的創作中⼼。可在 

Windows 和 Mac 的電腦上使⽤，包含了 2D 和 3D 場景的設計⼯具，為快速
和重複編輯提供的⽴即播放模式，以及強⼤的動畫控制系統。 

• 快速重複進⾏：按下播放，即可⽴即進入遊戲遊玩並預覽在指定平台最終

構建的樣⼦，可以隨時暫停並修改數值、資源、腳本和其它屬性並⽴即看
到結果，也可以每⼀幀逐步進⾏以⽅便調適並找出問題。 

• 獨特的可擴充⼯具：提供專⾨設計的 API 讓你可以⾃⼰為 Unity 編輯器擴
充，或者從 Asset Store 下載或購買其他開發者所製作的開發⼯具。 

• 各種強⼤又⽅便的系統：包含可以編輯過場動畫、遊戲順序、AI 尋徑、粒

⼦特效、動畫控制、即時光照、物理渲染、聲⾳混合、物理碰撞、腳本整
合及效能優化等等的編輯器視窗。 

• 無與倫比的匯入通道：⽀援匯入各種圖像、聲⾳、影像、⽂件等等格式的
檔案。 

• 範例觀摩：https://youtu.be/csP4JQprpog。 

1.2. 圖形渲染 

為場景畫⾯創造引⼈注⽬的氣氛。從明亮的⽩天到晚上霓虹燈的華麗光芒，

從清晨曙光到昏暗的午夜街道，建⽴動態的遊戲場景畫⾯。 

https://youtu.be/csP4JQprpog


• 即時渲染引擎：使⽤即時的全域光照與物理基礎渲染產⽣驚⼈的視覺真實
度。 

• 原⽣圖形 API：Unity ⽀援多平台，但仍保有接近各平台的低階圖形 
API，使你能夠利⽤最新 GPU 和硬體改善的優勢，如 Vulan、iOS Metal、
DirectX12、nVidia VRWorks 和 AMD LiquidVR。 

•  範例觀摩：https://youtu.be/44M7JsKqwow。 

1.3. 引擎效能 

頂級效能，使⽤不斷改進的引擎最佳化你的創作。 

• 進階分析⼯具：提供詳細資訊讓你了解如何改善效能。 

• 原⽣C++效能：使⽤ ILCPP 使跨平台持續進化。 

1.4. 跨平台 

構建⼀次並部署到任何地⽅，使受眾最⼤化。 

• 超過 25 個平台：跨越⼿機、桌機、遊戲機、電視、VR、AR 以及網⾴。 

• 引領 VR／AR：Unity 的通道輕鬆地將你的內容帶到最新的平台（⽀援 
Vuforia、Google Tango 以及即將到來的 Microsoft Mixed Reality）。 

https://youtu.be/44M7JsKqwow


1.5. 資源商店 Asset Store 

Asset Store 協助你快速開始開發並快速完成。無論是解決問題或是開發需求，

Asset Store 都是解決⽅案的所在。 

• 有現成的內容來提升你的 Unity 專案並使開發更簡單、快速。 

• ⼀⼤堆免費和付費的內容。 

• 無論什麼都有：美術作品、模型、程式腳本、⽣產⼒⼯具等等。 

• 網址：https://www.assetstore.unity3d.com/。 

1.6. 多⼈遊戲 Multiplayer 

Multiplayer 提供最簡單的⽅法來建⽴即時的網路遊戲。 

• 快速設置：快速實作並⾼度可客製化。 

• Unity 提供 Server：確保你的玩家能夠找尋到並與其他玩家⼀起玩。 

1.7. 團隊協作 Collaboration 

Collaboration 能夠使團隊更快速的運作，使創作團隊可以更有效率的共同⼯
作，以實現協作並簡化⼯作流程。 

• 儲存、分享以及同步妳的專案，並使⽤簡單的版本控管及雲端儲存空間，

全部都與 Unity 無縫整合。 

• 雲端構建：⾃動建⽴並與任何⼈分享構建。 

1.8. Unity Connect 

實現你的最終構想，Unity Connect 是個致⼒於 Unity 創作者的專業網路和⼈

才市場。 

• 使⽤免費的作品集展⽰你的⼯作。 

• 被尋找⼈才的⼈發現。 

• 與其他技術者交流，協助你克服障礙並實現你的最終構想。 

• 瀏覽業界⼯作或尋找機會。 

https://www.assetstore.unity3d.com/?aid=1101lGxc&pubref=UTPDF


1.9. 即時操作分析 Live Ops Analytics 

透過 Live Ops Analytics 即時洞察某些事物。使你能夠快速存取重要資訊，以

協助改善遊戲內經濟以及玩家體驗。 

• 完整的即時操作分析功能（遊戲和玩家分析、熱圖、效能監測）來監控玩
家⾏為。 

• 沒有 SDK！內建於 Unity 之中，所以沒有 SDK！ 

1.10.效能最佳化 

發現應⽤程式錯誤。Unity Performance Reporting 能夠讓你即時解決問題。 

• 查找並解決你的⽤⼾正在經歷的最優先級問題。 

• 跨越設備和平台即時收集並反應出應⽤程式錯誤。 

1.11.貨幣化 

⽤最簡單的⽅式增加收入。Unity 提供內建的解決⽅案，使你的成功最⼤化。 

• 創造收入的解決⽅案：廣告聯播及應⽤內消費。 

• ⼀套完整的即時操作分析功能來監控玩家⾏為。 

• 持續改善：即時地為你運⾏中的遊戲改善效能，無需重新部署，並透過數

據分析的⼒量增加使⽤者⽣命週期價值。 

1.12.廣告 

取得新⽤⼾。在 Unity Ads 刊登廣告，直接獲得新⽤⼾。 

• 獲取優質的遊戲以及娛樂清單。 

• 集中在⽬標受眾。 

• 在正確的地點、時間接觸受眾。 

1.13.病毒式⽤⼾增長 

使⽤ Everyplay，你的⽤⼾能夠分享他們表現最佳時的影⽚並對他們的朋友分
享你的遊戲。 



2.下載 Unity 安裝程式 
2.1. 下載最新版 

(1) 前往官⽅網站：https://unity3d.com，點擊 Get Unity。 

(2)點擊免費個⼈版（Personal）的 Try Personal 按鈕。 

https://unity3d.com


(3)勾選「By clicking, I confirm that I am eligible to use Unity Personal per 
the Terms of Service, including the limitations described above」表⽰確

認符合個⼈版使⽤資格，並點擊「Download Installer」下載安裝助理程
式。 

2.2. 下載指定版本 

(1) 承上 (1)。 

(2)網⾴最下⽅點擊 Older versions of Unity。 



(3)可依照需求選擇不同的 Unity 版本以及不同安裝平台的安裝程式。 



3.安裝 Unity 開發引擎 

(1) 執⾏所下載的安裝程式（如 UnityDownloadAssistant 2017.1.0f3.exe）開啟安裝
助理視窗，點擊 Next 按鈕。 

 



(2)勾選「I accept the terms of the License Agreement」同意許可證協議，並點擊 

Next 按鈕。 

 



(3)勾選需要安裝的項⽬，然後點擊 Next 按鈕。 

• Unity 2017.1.0f3：Unity 編輯器主程式。 

• Documentation：Unity 使⽤⼿冊與 API 參考⽂件。 

• Standard Assets：Unity 內建提供的標準資源包。 

• Example Project：使⽤ Standard Assets 所製作的範例專案。 

 



(4)選擇下載與安裝位置，然後點擊 Next 按鈕。 

• 選擇 Download files to temporary location (will automatically be 
removed when done) 使安裝時下載到暫存位置並在安裝完畢後⾃動刪

除。 

• 確認 Unity 安裝的資料夾路徑，使⽤不同資料夾名稱可使電腦裡同時安裝
多個不同版本的 Unity。 

 



(5)檢查是否有影響安裝程序的程式必須關閉。 

(6)下載所選擇需要安裝的相關檔案。 



(7)開始安裝。 

(8)安裝完成，可勾選 Launch Unity（預設）表⽰直接執⾏ Unity，點擊 Finish 按
鈕結束安裝。 



4.建⽴ Unity ID 
(1) 前往官⽅網站：https://unity3d.com，點擊右上角的頭像圖⽰。 

(2)在展開的⾴⾯區塊，點擊 Create a Unity ID 按鈕。 

https://unity3d.com


(3)在 Email 欄位輸入電⼦信箱位址，此信箱將做為未來登入⽤的 Unity ID。 

(4)在 Password 欄位設定密碼，密碼必須至少 8 個字元並至少要有⼀個⼤寫字母、
⼩寫字母、數字。 



(5)在 Username 欄位設定匿稱，此名稱將⽤於 Unity 社群論壇。 

(6)在 Full Name 欄位設定帳號資料全名。 



(7)依據指⽰點擊驗證圖⽰，如下圖，指⽰為點擊 Unity 圖⽰。 

(8)勾選「I agree to the Unity Terms of Use and Privacy Policy」表⽰同意使⽤條
款和隱私政策，然後，點擊 Create a Unity ID 按鈕。 



(9)開啟信箱收取 Unity ID 確認信件，並點擊「Link to confirm email」連結確認
電⼦信箱位址。 

(10) 你的 Unity ID 已確認，關閉⾴⾯並繼續登入。 



(11) 回到建⽴ Unity ID 的⾴⾯，點擊 Continue 按鈕即可登入。 

 



5.啟⽤授權 
(1) 開啟 Unity 2017.1。 

(2)輸入建⽴ Unity ID 的信箱和密碼，然後，點擊 Sign in 按鈕。 



(3)確認許可證授權。 

(4)選擇個⼈版（Personal），並點擊 Next 按鈕。 



(5)許可證協議選擇「I don't use Unity in a professional capacity」，並點擊 Next 
按鈕。 

(6)再次確認並更新許可證授權。 



(7)檢索調查。 

(8) Unity ID 初次使⽤ Unity 必須填選的問卷調查。選擇所在地以及主要使⽤ Unity 
的能⼒。 



(9)選擇主要角⾊是什麼。 

(10) 選擇⾃我評價 Unity 技能的程度為何。 



(11) 選取對哪些平台感興趣。 

 



(12) 選擇主要計畫使⽤ Unity 來開發哪種類型的內容。 

(13) 選填完畢後，點擊 OK 按鈕。 



(14) 完成啟⽤。 

(15) 開始使⽤ Unity。 



II.開發與學習資源 
有很多的⽅法可以幫助學習 Unity，從官⽅所提供的學習資源，可以找到任
何能夠幫助你成為 Unity 開發者的東西。同時，不管是在開發或學習上，勢
必也需要各種資源檔案來提供專案及其內容使⽤， 

1.教程 Tutorials 
https://unity3d.com/learn/tutorials  
Unity 官⽅網站所提供的教程，主要分為兩個部分： 

• 專案式：以遊戲實作專案為主，依照步驟來逐步完成專案內容，透過實作來有
效理解引擎功能與實務使⽤，包含滾球、太空射擊、⽣存射擊、坦克對戰、2D 

程序化關卡、冒險遊戲、洞穴⽣成等。 

• 主題式：更詳細的分析及舉例解說引擎各系統或功能的系列教學，如編輯器介

⾯基礎、2D 遊戲創作、程式腳本、圖像、物理、聲⾳、動畫、使⽤者介⾯、⼿
機觸碰、導航、廣告與統計、虛擬實境、效能改善、多⼈連線等等。 

2.⽂件資料 Documentation 
Unity 官⽅網站或可隨 Unity 主程式⼀起安裝的⽂件資料，提供最詳細的說明和簡

單範例，主要分為兩個部分： 

• 使⽤⼿冊：https://docs.unity3d.com/Manual/index.html  
提供有關如何使⽤ Unity 編輯器以及相關服務的詳細圖⽂說明，每個⾴⾯皆可
切換到不同的 Unity 版本查看其相關說明，主要章節包含有完整的編輯器介
紹、Unity 2D、圖像、物理、網路、程式腳本、聲⾳、動畫、使⽤者介⾯、導

航、Unity 服務、虛擬實境、指定平台等等。 

• 編程參考：https://docs.unity3d.com/ScriptReference/index.html  
包含詳細的編寫程式所需要的 API 參考資料，程式寫作所必須閱讀與查找的資
料都在這裡，提供各種功能的解說和程式範例，為使⽤ Unity 開發遊戲、應⽤
程式或開發⼯具等最核⼼的資料資源。 

https://unity3d.com/learn/tutorials
https://docs.unity3d.com/Manual/index.html
https://docs.unity3d.com/ScriptReference/index.html


3.直播教學 Live training 
https://unity3d.com/learn/live-training  
不定期針對各種主題，由 Unity 原廠提供的專家在線上以現場直播的⽅式開講，使
學員能夠透過網路即時互動、提問︔開播之前會預告主題以及開播時間倒數，每次

⼤約 1~2 ⼩時，如果未能及時參與，也能於網站上查找存檔影⽚學習。 

4.認證開發者課件 Certified Developer 
Courseware 
https://certification.unity.com/courseware  
更完整的系列教學課程資源，需要付費購買才可使⽤，另外，訂購 Unity Plus、
Unity Pro、Unity Enterprise 的⽤⼾，可享有 1~3 個⽉的免費使⽤權。 

5.資源商店 Asset Store 
https://www.assetstore.unity3d.com/ 
在開發或學習的過程中，透過 Asset Store 中的資源可以節省時間、提⾼效率。包
含⼈物模型、動畫、粒⼦特效、紋理、遊戲創作⼯具、⾳效／⾳樂、可視化程式編

寫⽅案、功能程式腳本或其他各類擴充插件等都能在這裡免費或付費的⽅式獲得。 

https://unity3d.com/learn/live-training
https://certification.unity.com/courseware
https://www.assetstore.unity3d.com/


III.2D 與 3D 遊戲專案概念 
Unity 是同時適⽤於 2D 和 3D 遊戲的開發⼯具。當你在 Unity 中建⽴⼀個
新的專案，你必須先選擇是要從 2D 或 3D 模式開始。你有可能已經知道你
想要建⽴的是什麼，但是，有幾個細微的問題可能會影響你的選擇。 

1.全 3D 
3D 遊戲通常是使⽤具備材質和紋理的三度空間幾何描繪在遊戲物件的表⾯，使它
們呈現⽴體般的環境、⼈物角⾊以及構成遊戲世界的物件。攝影機可以⾃由的在場

景內和周圍⾃由的移動，⽽光源和陰影則以逼真的⽅式投射到世界的每個地⽅。 

3D 遊戲通常使⽤透視的⽅式來描繪場景，所以物件越靠近到攝影機，則在畫⾯上
呈現的越⼤。 

對於適合以上描述的所有遊戲，都可以 3D 模式開始。 

以下為 Unity 官⽅放於 Asset Store 上的⽰範專案 3D 場景： 

• Vikin Village： 
https://www.assetstore.unity3d.com/#!/content/29140 

https://www.assetstore.unity3d.com/#!/content/29140?aid=1101lGxc&pubref=UTPDF


• Corridor Lighting Example： 
https://www.assetstore.unity3d.com/#!/content/33630 

• Stealt（Unity 4x）： 
https://www.assetstore.unity3d.com/#!/content/7677 

https://www.assetstore.unity3d.com/#!/content/33630?aid=1101lGxc&pubref=UTPDF
https://www.assetstore.unity3d.com/#!/content/7677?aid=1101lGxc&pubref=UTPDF


2.正交 3D 

有時候，遊戲使⽤ 3D 幾何，但是攝影機使⽤正交來取代透視。這在遊戲上是很常
⾒的技術，提供給你⼀個⿃瞰的視野來運作，有時候，這也被稱為「2.5D」。 

如果你正在製作⼀個像這樣的遊戲，你應該也是使⽤ 3D 模式，因為雖然這樣沒有
透視，但你仍然是使⽤ 3D 模型和資源來運作。 

此時，你必須將攝影機和場景視窗切換為正交（Orthographic）。 

3.全 2D 
許多 2D 遊戲使⽤平⾯圖像，有時候也稱為 Sprite，它們根本都沒有三度空間幾
何。 
它們做為平⾯圖像直接繪製到螢幕上，⽽且遊戲的攝影機沒有透視。 
對於這種類型的遊戲，應該以 2D 模式啟動編輯器。 
Unity 官⽅在 Asset Store 提供的 2D 專案： 

• 2D Platformer： 
https://www.assetstore.unity3d.com/#!/content/11228 

https://www.assetstore.unity3d.com/#!/content/11228?aid=1101lGxc&pubref=UTPDF


• 2D Roguelike： 
https://www.assetstore.unity3d.com/#!/content/29825  

• 2D Roguelike： 
https://www.assetstore.unity3d.com/#!/content/73728 

https://www.assetstore.unity3d.com/#!/content/29825%E2%80%A8?aid=1101lGxc&pubref=UTPDF
https://www.assetstore.unity3d.com/#!/content/73728?aid=1101lGxc&pubref=UTPDF


4.具備 3D 圖像的 2D 遊戲 

有些 2D 遊戲針對環境和角⾊使⽤ 3D 幾何，但是將遊戲限制在⼆度空間上。例
如，攝影機可能會顯⽰橫軸視野，並且玩家只能在⼆度空間裡移動，但是遊戲本身

仍然使⽤ 3D 模型的障礙物和  3D 透視視野的攝影機。 

對於這類遊戲，3D 效果可能主要提供畫⾯風格，⽽非功能上的⽬的。這類的遊
戲，有時候也會被稱為「2.5D」。 

雖然是 2D 遊戲玩法，但你主要是操作 3D 模型來建⽴遊戲，因此應該以 3D 模式
啟動編輯器。 

5.具備透視攝影機的 2D 遊戲玩法和圖像 

另⼀種很受歡迎的 2D 遊戲風格，使⽤ 2D 圖像，但是帶有透視攝影機以獲得視差
捲動的效果。 

這是種「紙板劇場」風格的場景，這裡的所有圖像都是平⾯的，但是佈置在與攝影
機不同距離位置。這種情況下， 

2D 模式將會是最適合你的開發⽅式。然⽽，你應該將攝影機的投影模式改變為透

視（Perspective）並將 Scene 視窗設置為 3D。 



6.其它類型 
或許你計劃的專案適合以上所介紹的其中⼀種，或者，你可能會有⼀些其它完全不
同或獨特的東西。無論你的計畫是怎樣的，希望以上能帶給你啟動編輯器模式的⼀

些想法。 

請記住，你可以隨時切換模式。 

7. 2D 和 3D 模式設定 
當建⽴⼀個新專案，你可以指定是要從 2D 或是 3D 模式開啟 Unity 編輯器。無論

如何，你還可以隨時在 2D 和 3D 模式之間切換編輯器。 

7.1. 在 2D 和 3D 模式間切換 

(1) 透過選單 Edit > Project Settings > Editor 開啟編輯器設定 - Editor 
Settings。 



(2)設置 Defaut Behavior Mode 為 2D 或 3D。 

7.2.  2D 和 3D 模式的影響 

(1) 2D 模式： 

• 假定匯入的所有圖像都是要做為 2D 圖像（Sprite）使⽤並預設為 Sprite 
模式。 



• Sprite Packer 被開啟。 

• Scene 視窗設置為 2D。 

• 預設的場景遊戲物件沒有定向光源（Directional Light）。 

• 攝影機的預設位置為 (0,0,-10)。 

• 攝影機預設為正交（Orthographic）。 



• Lighting 視窗： 

- 建⽴新場景時，沒有使⽤ Skybox。 

- 環境光來源（Ambient Source）設置為 Color（深灰⾊，R 54、G 
58、B 66）。 

- 預計算即時全域光照（Precomputed Realtime GI）關閉。 

- 烘焙全域光照（Baked GI）關閉。 

- ⾃動⽣成（Auto Generate）關閉。 

(2) 3D 模式： 

• 不會假定匯入的所有圖像都是要做為 2D 圖像（Sprite）使⽤。 

• Sprite Packer 關閉。 



• Scene 視窗設置為 3D。 

• 預設的場景遊戲物件有定向光源（Directional Light）。 

• 攝影機的預設位置為 (0,1,-10)。 

• 攝影機預設為透視（Perspective）。 



• Lighting 視窗： 

- Skybox Material 內建預設的 Skybox。 

- 環境光來源（Ambient Source）設置為 Skybox。 

- 預計算即時全域光照（Precomputed Realtime GI）開啟。 

- 烘焙全域光照（Baked GI）開啟。 

- ⾃動⽣成（Auto Generate）開啟。 



IV.建⽴遊戲專案與專案結構
介紹 
1.建⽴新專案 

(1) 點擊 NEW 或 New Project 按鈕，準備建⽴新專案。 

• 如果安裝於此電腦的 Unity 曾經開啟過其它專案，此處會列出那些專案名
稱以及專案檔案所儲存的路徑，直接點擊專案名稱即可開啟該專案。 

• 如果要開啟未列於此處的舊專案，可點擊右上⽅的 OPEN，透過檔案／資
料夾選擇視窗來選取並開啟舊專案。 

• 由於，⽬前希望建⽴⼀個全新的專案，所以，在此直接點擊右上角的 

NEW，表⽰要建⽴新專案。 



(2) 設置新專案。 

1)命名專案名稱： 
專案名稱應該以英⽂字母及數字為主，避免使⽤中⽂名稱或特殊符號，此

處命名之專案名稱將⽤來做為所建⽴的專案資料夾名稱。 

2)選擇 3D 或 2D 的專案類型： 
選擇預計開發的專案內容主要為 3D 或 2D，這將會影響到匯入資源以及建

⽴新場景時的相關預設值，此項⽬在建⽴專案之後，可於編輯器中隨時更
改。 

3)選擇專案儲存路徑： 
指定專案資料夾所要存放的路徑位置，該路徑應該皆為英⽂字母及數字，
避免有中⽂字或特殊符號。 

4)點擊 Create Project 按鈕，開始建⽴專案。 



(3) 完成建⽴新專案，Unity 視窗的標題列： 

1)⽬前所使⽤的 Unity 版本。 

2)⽬前開啟的場景名稱。 

3)專案名稱。 

4)⽬前編輯的⽬標平台。 



2.專案結構 
2.1. 專案資料夾： 

在 Unity 編輯器上⽅的選單列選擇 Assets > Show in Explorer 或在 Project 視窗
點擊滑鼠右鍵開啟選單選擇 Show in Explorer，可開啟專案資料夾。 

1) 專案名稱同時也是專案資料夾的名稱。 

2) Assets 資料夾：資料夾內的檔案，由使⽤者透過 Unity 編輯器建⽴，是實際
在 Unity 編輯器內所使⽤的資源檔案，這個資料夾裡⾯的檔案更動（新增、修

改名稱、刪除等）必須都在 Unity 編輯器內操作，以免發⽣無法預期的錯誤。 

3) Library 資料夾：由 Unity ⾃動建⽴與操作的資料夾內容檔案，如無必要，使

⽤者不應對此資料夾或其中的檔案進⾏任何操作。 

4) ProjectSettings 資料夾：主要存放此專案相關的設定檔案，由 Unity ⾃動產⽣
以及維護內容，於 Unity 編輯器中的 Edit > Project Settings 選單項⽬所設定

的內容就是記錄在此。 

5) Temp 資料夾：此為 Unity 運⾏時，⾃動產⽣的資料夾，其中某些檔案會被 

Lock，將可能影響到專案搬移或刪除︔關閉 Unity 後，此資料夾會⾃動刪



除︔如果在 Unity 未開啟此專案時，就已有 Temp 資料夾，表⽰可能上次 
Unity 並未正常關閉，可讓 Unity 重新開啟此專案再關閉，即可刪除。 

2.2. 專案與場景 Project & Scenes： 

• Unity 應⽤或遊戲內容，是由許多個別獨⽴的場景所組成。 

• 在 Unity 編輯器中所製作和編輯的內容，主要是⽤來建設場景內容。 

• 每個場景在儲存之後，會成為專案內的場景資源檔案。 

• 專案主要是管理所有的資源檔案以及資源的設定值，如場景、資料設定、動
畫控制、動畫剪輯、字型、影⽚、⾳源、圖⽚、模型、材質、程式腳本、預

置元件（Prefab）檔案...等等。 



V.⼯具介⾯的使⽤ 
花點時間查看編輯器介⾯並熟悉它。主要的編輯器視窗是由標籤視窗所組成，
能夠重新排列、分組、分離和停靠。 

這意味著根據個⼈喜好以及正在做的⼯作，編輯器外觀將會隨著不同的專案
及不同的開發者⽽不相同。 

預設的視窗安排可讓你實際訪問到最常⽤的視窗。你可以透過標籤的名稱來
辨認它們，並可依照⾃⼰的喜好重新拖拉排列或關閉視窗，也可透過選單列
的 Window 選單來開啟其他視窗。 

 



• Hierarchy 視窗：列出場景中全部的遊戲物件名稱，以及物件⽗⼦關係的層次結構，
可透過點擊名稱來選取遊戲物件，或拖拉名稱來改變⽗⼦關係與排序。是場景中所有

物件的層次結構⽂字表現。Scene 視窗中的每個東西在 Hierarchy 視窗都有⼀個條
⽬，所以這兩個視窗的內部是互相連接的。 

• Scene 視窗：⽤來編輯場景遊戲物件的位置、旋轉、縮放，讓你能夠視覺化的瀏覽和
編輯你的場景。Scene 視窗能夠顯⽰ 3D 或 2D 視角，取決於你所運作的專案類型。 



• Game 視窗：從場景中的鏡頭視野所呈現的畫⾯，也是玩家在遊戲中所看到的實際畫
⾯，可直接⽤來觀察和測試製作結果。 

• Asset Store 視窗：Unity 專屬的資源商店平台，可免費或付費獲得各種開發相關的資
源與擴充⼯具或學習範例。 



• Inspector 視窗：使你能夠查看並編輯⽬前所選取的遊戲物件、資源檔案等的屬性，
所呈現的視窗內容，將隨著所選取的遊戲物件或資源檔案不同⽽有所不同。 

• Project 視窗：即是專案資料夾裡的 Assets 資料夾內容，顯⽰專案中能夠使⽤的資源
庫。匯入到專案中的資源，會出現在這裡。 



• Console 視窗：⽤於顯⽰使⽤者程式裡所輸出的⼀般訊息以及其它警告或錯誤訊息，
同時也提供所追蹤的訊息來源資訊。 

• ⼯具列：提供存取⼤部分基本⼯作的功能。左側包含操作 Scene 視窗中物件的基本⼯
具。中間是執⾏、暫停與逐步執⾏的控制⼯具。右邊的按鈕是提供你訪問 Unity 雲湍
服務（Cloud Services）以及帳號、可⾒物件層的選單以及編輯器排列選單（提供⼀

些替換的編輯器視窗佈局並讓你能夠儲存⾃⼰的⾃訂佈局）。 
⼯具列不是視窗，只是 Unity 介⾯的部分，所以不能重新排列其位置。 



VI.遊戲資源⼯作流程 
資源，代表可以⽤於你的遊戲或專案中的任何東西。資源可能來⾃於 Unity 
外部所建⽴的檔案，如 3D 模型、聲⾳檔、圖⽚或任何其它各種 Unity ⽀援
的檔案。還有⼀些資源類型可以在 Unity 中建⽴，如動畫控制器
（Animator Controller）、聲⾳混合器（Audio Mixer）或渲染紋理
（Render Texture）。 

1.原型物件 
Unity 可以使⽤任何使⽤建模軟體建⽴的各種形狀的 3D 模型。然⽽，也有⼀些原
型物件可以直接在 Unity 中建⽴，即是⽴⽅體（Cube）、球體（Sphere）、膠囊體

（Capsule）、圓柱體（Cylinder）、平⾯（Plane）以及四邊形（Quad）。這些物
件本身的功⽤常常很有⽤（例如，平⾯通常⽤來做為平坦的地⾯），⽽它們還可以
為了測試⽬的，提供便捷快速的⽅法來建⽴標⽰和原型樣品。任何原型物件都可以

使⽤ GameObject > 3D Object 選單的合適項⽬來添加到場景。 

 



• ⽴⽅體 Cube 

這是使⽤⼀個單位長度的簡單⽴⽅體，其紋理為六個⾯重複的圖像。 

在⼤部分的遊戲裡，Cube 不會是很常⾒的物件，但是透過縮放，在做為牆壁、

柱⼦、箱⼦、階梯以及其它類似的物品時會非常有⽤。 

在開發期間，當完整的模型還不能使⽤時，對程式⼈員來說，它也是非常⽅便的
標⽰物件。例如，⼀輛⾞體可以使⽤⼤致正確尺⼨的細長 Cube 粗略地塑造。 

雖然這不適合於完成的遊戲，但為了測試⾞輛控制的程式碼，做為簡單的代表物
件是很好⽤的。 

由於 Cube 的邊長為⼀個單位，因此，你可以透過添加⼀個⽤於比較尺⼨的 
Cube 來檢查匯入到場景中的網格（Mesh）比例。 

• 球體 Sphere 

這是⼀個單位直徑的球體（即 0.5 單位的半徑），其紋理使得整個圖像在其極點
的頂部和底部「擠壓」整個圍繞包裹住。 



Sphere 對於代表球、⾏星和射彈是很有⽤的，⽽半透明球體製作 GUI 來表⽰⼀
種效果的半徑。 

• 膠蘘體 Capsule 

Capsule 是在兩端具有半球形蓋⼦的圓筒。這種物件有⼀個單位直徑和兩個單位
⾼（身體部份是⼀個單位以及兩個蓋⼦各有半個單位）。其紋理使圖像剛好圍繞

包住並擠壓在兩個半球的頂點。 

雖然沒有很多真實世界的物件具有這種形狀，但 Capsult 針對遊戲原型的製作是
很有⽤的標⽰物。特別是有時候針對某些任務，⽤於圓形物件的物理會比⽅體還

要好。 

• 圓柱體 Cylinder 

⼀個簡單的 Cylinder 是兩個單位⾼以及⼀個單位直徑，其紋理使得圖像環繞身
體的管狀區域，但同時也會分別出現在兩個平的圓形端部。 

Cylinder 非常⽅便於建⽴柱⼦、竿⼦和輪⼦，但要注意其碰撞器的形狀實際上是
個膠蘘（Unity 中沒有原⽣的柱體碰撞器）。如果需要準確的圓柱形碰撞器進⾏



物理⽬的，你應該要在建模軟體中建⽴適當形狀的網格，然後為其附加網格碰撞
器（Mesh Collider）。 

• 平⾯ Plane 

這是個使⽤⼗單位長度邊，定位在區域座標空間的 XZ 平⾯上的⼀個平坦的正⽅
形，其紋理讓整個圖像呈現在正⽅形內。 

Plane 在⼤多數的平⾯表⾯很有⽤，如地板和牆壁。有時候針對顯⽰圖像或在 
GUI 移動和特殊效果也會有需要。雖然 Plane 可以有這些⽤處，但更簡單的四邊
形（Quad）可能會更適合。 

• 四邊形 Quad 

Quad 類似於 Plane，但它的邊只有⼀個單位長，並且其表⾯是定位在區域座標
空間的 XY 平⾯上。另外，Quad 被劃分成 2 個三角形，⽽ Plane 則有 200 個。 



在場景物件必須簡單的做為圖像或電影顯⽰螢幕的情況下，Quad 是很有⽤的。
間單的 GUI 和訊息顯⽰，可以使⽤ Quad 來實現，像是粒⼦、Sprite 和遠距離的

⽴體物件的替代「假」圖像。 

2.匯入資源 
在 Unity 的外部建⽴的資源，必須透過將檔案直接儲存到專案的 Assets 資料夾，或
者複製到該資料夾，才能進入到 Unity 之中。對於許多常⾒的格式，你可以直接將

你的來源檔案儲存到專案的 Asset 資料夾，Unity 將能夠讀取到。當你對該檔案儲
存新的變更，Unity 會注意到並且根據需要⽽重新匯入。 

當你建⽴專案時，會建⽴⼀個與專案名稱相同的資料夾，其中包含⼀些⼦資料夾： 

Assets 資料夾是你應該⽤來儲存或複製專案中要使⽤的檔案的位置。 

Unity 中的 Project 視窗內容顯⽰ Assets 資料夾內的東西。因此，如果儲存或複製

檔案到 Assets 資料夾中，將會被匯入並可在 Project 視窗中看⾒。 

當檔案被添加到 Assets 資料夾中或者檔案被修改，Unity 將會⾃動檢測。當你放任
何資源到 Assets 資料夾，將會看到資源出現在 Project 視窗。 



如果你從你的電腦拖拉檔案到 Unity 的 Project 視窗（例如，從 Mac 的 Finder 或
是從 Windows 的檔案總管），檔案將被複製到 Assets 資料夾，並顯⽰在 Project 

視窗。 

⼤多數情況下，在 Project 視窗所看到的項⽬也代表是在電腦裡的真實檔案，假如
你從 Unity 中刪除它們，也會同時在電腦中被刪除掉。 

上圖顯⽰了 Unity 專案的 Asssets 資料夾中的幾個檔案和資料夾。你可以根據喜好
建⽴許多資料夾並使⽤它們來組織你的資源。 

上圖可以注意到，在檔案系統中列出的 .meta 檔案，但是在 Unity 的 Project 視窗
中並沒有。Unity 為每個資源和資料夾建⽴這些 .meta 檔案，但預設是隱藏的，所
以你可能在你的電腦檔案系統中並不會看到。它們包含了關於資源在專案中如何使

⽤的重要訊息，並且必須與其相關的資源檔案共同被保留，所以，如果你在電腦的
檔案系統中（檔案總管／Finder）搬移或重新命名資源檔案，你也必須搬移或重新

命名相關的 .meta 檔案。安全搬移或重新命名資源的最簡單⽅法就是始終從 Unity 
的 Project 視窗中動作。這麼做，Unity 將⾃動的搬移或重新命名相對應的 .meta 檔
案。 

3.常⾒的資源類型 
• 圖形檔案： 
⼤部分常⾒的圖形檔案都有⽀援，例如 BMP、TIF、TGA、JPG 以及 PSD。如

果儲存圖層化的 Photoshop（.psd）檔案到 Assets 資料夾，它們將被做為整平的
圖像來匯入。 

• 3D 模型檔案： 
如果你從⼤多數常⾒的 3D 軟體使⽤它們的原⽣格式儲存 3D 檔案
（如 .max、.blend、.mb、.ma）到 Assets 資料夾，它們將透過調⽤你的 3D 軟



體的 FBX 匯出插件來將其匯入。或者，你也可以從你的 3D 軟體匯出為 FBX 格
式再匯入到 Unity 專案。 

• 網格和動畫： 
無論你使⽤哪種 3D 軟體，Unity 將從每個檔案匯入其網格和動畫。 
網格檔案不必匯入動畫。如果你要使⽤動畫，可以選擇從單⼀個檔案匯入全部的

動畫，或者從每個帶有⼀個動畫的個別檔案匯入。 

• 聲⾳檔案： 
如果儲存未壓縮的聲⾳檔案到 Assets 資料夾，將根據所指定的壓縮設定來匯
入。 

• 其它資源類型： 
在任何情況下，你的原始來源檔案不會被 Unity 所修改，即使是在 Unity 內，你
會時常在各種⽅法間選擇壓縮、修改或以其它⽅式處理資源。其匯入過程是讀取

來源檔案，並建⽴內部符合你所選擇匯入設定的資源描述，以準備給遊戲使⽤。
如果為資源修改匯入設定，或者在 Assets 資料夾修改來源檔案，將導致 Unity 
重新匯入資源以反應新的改變。 

注意：匯入原⽣ 3D 格式，需要有該 3D 軟體安裝在相同的電腦中。這是因為 Unity 
使⽤ 3D 軟體的 FBX 匯出器插件來讀取該檔案。或者，你可以直接從應⽤軟體匯出 

FBX 檔案儲存到 Unity 的專案資料夾中。 



4.匯入設置 
每種 Unity ⽀援的資源都有其匯入設置，它們會影響資源的顯⽰和⾏為。在 
Project 視窗選擇資源以顯⽰資源的匯入設置，該資源的匯入設置將會出現在 

Inspector 視窗。所顯⽰的選項將依據所選擇的資源種類⽽有所不同。 

例如，圖像的匯入設置能夠讓你選擇是被匯入為紋理、2D Sprite 或法線貼圖。
FBX 檔案的匯入設置讓你能夠調整縮放、⽣成法線或是光照貼圖座標，以及分割和

修剪檔案中定義的動畫⽚段。 

對於其它資源類型，匯入設置將看起來不同。各式各樣的設置會與所選擇的資源相
關。下圖⽰範聲⾳資源在 Inspector 視窗顯⽰相關的匯入設置。 

如果開發跨平台的專案，你可以撤銷「預設」設置並在每個平台配置不同的匯入設
置。 



5.從 Asset Store 匯入 
Unity Asset Store 是由 Unity Technologies 以及社群成員所建⽴持續成長的免費及
商⽤資源庫的所在地。有各式各樣的資源可⽤，涵蓋從紋理、模型和動畫到整個專

案範例、教學和編輯器擴充的所有內容。資源從 Unity 編輯器內建的簡單界⾯進⾏
存取並直接下載匯入到專案中。 

Unity 使⽤者可以成為 Asset Store 上的發佈商，並銷售所創建的內容。 

• 訪問並瀏覽 Asset Store 

可以透過選單列的  Window > Asset Store 開啟 Asset Store 視窗。第⼀次造訪，

會被提⽰去建⽴免費的使⽤者帳號，隨後將⽤來存取 Asset Store 的內容。 

Asset Store 提供類似瀏覽器的介⾯，使你能夠透過⽂字搜尋或分類來進⾏瀏覽。
左側的⼯具欄是令⼈熟悉的瀏覽按鈕，⽤來瀏覽查看過的歷史紀錄項⽬。 

稍右邊的按鈕則可查看下載管理器（Download Manager）以及查看⽬前的購物
⾞內容。 



下載管理器使你能夠察看已經購買過的資源包，還可以查找和安裝任何更新。此
外，Unity 提供的標準資源包可以使⽤相同的介⾯查看並添加到專案中。 

• 已下載的資源檔案位置： 

很少會需要直接訪問從 Asset Store 下載的檔案，但是，如果有需要，可以從這
些位置找到。 

- Mac：~/Library/Unity/Asset Store 

- Windows：C:\Users\使⽤者名\AppData\Roaming\Unity\Asset Store 

這些資料夾包含相對應的 Asset Store 供應商名稱的⼦資料夾，實際的資源檔案
會包含在相對應的⼦資料夾中。 



VII.製作與匯入資源包 
Unity 的資源包（Package）是分享以及重複使⽤ Unity 專案和所收集資源
的便利⽅法，例如，Unity 的標準資源（Standard Assets）以及在 Unity 
Asset Store 上的東西都是使⽤資源包來提供 。 

資源包是來⾃ Unity 專案或者專案元素的檔案和資料的集合，它們被壓縮並
儲存在⼀個檔案中，類似於 Zip 檔案。 

就像 Zip 檔案⼀樣，資源包解開時會維持原本的資料夾結構以及與資源相關
的 meta 資料（例如匯入設置和與其它資源相關的連結）。 

在 Unity 中，選單項⽬「Export Package」壓縮並儲存其集合，⽽「Import 
Package」解開集合內容到你⽬前開啟的 Unity 專案中。 

1.匯入資源包 
你可以匯入 Unity 提供的預製資源集合「標準資源包（Standard Asset 
Packages）」以及⾃定資源包（Custom Package），它們都是使⽤ Unity 製作

的。 



選擇 Assets > Import Package 選單來匯入它們。 

2.標準資源包 
Unity 的「標準資源」（Standard Assets）是由各種包裝所組成：2D、

Cameras、Characters、CrossPlatformInput、Effects、Environment、
ParticleSystems、Prototyping、Utility、Vehicles。 

匯入新的標準資源包： 

1. 開啟想要匯入資源的專案。 

2. 選擇 Assets > Import Package > 資源包名稱，之後會顯⽰ Import Unity 

Package 視窗，伴隨著顯⽰包裝中的所有東西並預先勾選，接著就準備安裝了。 

3. 點擊 Import 按鈕，Unity 會將資源包的內容放入 Project 視窗中的 Standard 
Asset 資料夾中。 



3.⾃定資源包 
你可以匯入從你⾃⼰的專案或其它 Unity 使⽤者製作的專案所匯出的⾃定資源
包。 

匯入新的⾃定資源包： 

1. 開啟想要匯入資源的專案。 

2. 選擇 Assets > Import Package > Custom Package... 來開啟檔案總管

（Windows）或 Finder（Mac）。 

3. 選擇想要匯入的資源包檔案，並顯⽰ Import Unity Packgae 視窗，伴隨著顯⽰

包裝中的所有東西並預先勾選，接著就準備安裝了。 

4. 點擊 Import 按鈕，Unity 會將資源包的內容放入 Project 視窗中的 Assets 資料
夾裡。 



4.匯出資源包 
使⽤ Export Package 來建⽴你⾃⼰的⾃定資源包（Custom Package）。 

1. 開啟想要匯出資源的專案，並選擇想要匯出的資源檔案。 

2. 選擇 Assets > Export Package...，開啟 Exporting Package 視窗。 

3. 在視窗中，確認選取所想要包含在資源包中的資源。 

4. 保留 include dependencies 選取，以⾃動選擇與所使⽤資源相關的檔案。 

5. 點擊 Export 按鈕開啟檔案總管（Windows）或 Finder（Mac）並選擇想要儲存
資源包檔案的位置，然後為其命名並儲存。 

匯出資源包時，Unity 能夠匯出所有相依賴的項⽬。例如，如果選擇⼀個場景檔
案，並附帶所有相依賴項⽬來匯出，那麼，所有的模型、紋理和其它資源也都會⼀
起匯出。這樣可以快速地匯出⼀堆資源，⽽不⽤全部⼿動查找。 



5.匯出更新的資源包 
有時候可能想要改變資源包的內容並建⽴新的資源包更新版本。可以這麼做： 

1. 選擇資源包所需的檔案（選擇未改變的和新的資源）。 

2. 使⽤ Export Package 如上所述的匯出檔案。 

注意：可以重新命名已更新的資源包，Unity 將會辨識出它做為更新，所以可以使
⽤遞增編號來命名，例如：MyAssetPackageVer1、MyAssetPackageVer2。 

從資源包裡移除檔案，然後使⽤相同名稱的檔案來取代，這並不是好的做法︔
Unity 會辨識出它們為不同的資源，⽽且可能會認為是衝突的檔案，因⽽在它們被

匯入的時候顯⽰警告。假如已經移除檔案並決定替換它，最好的做法，是給它⼀個
與原來不同但又相關的名稱。 



VIII.標準資源包 
Unity 帶有多個標準資源，這是提供給廣⼤使⽤者的資源集。 

1. 2D 
匯入 2D 資源包裡除了 2D 相關的資源之外，還包含了相關的 CrossPlatformInput 
以及 Utility 的資源必須同時匯入。 

在 Standard Assets > 2D > Prefabs 資料夾裡，有⽴即可⽤的預置元件，直接拖拉
到場景中，就能開始編輯 2D 遊戲場景： 

• CharacterRobotBoy：可控制前進、蹲伏、蹲伏前進和跳躍的 2D 機器⼈角⾊。
角⾊的 Platformer Character 2D 組件提供可調整的欄位： 

- Max Speed：前進速度。 

- Jump Force：跳躍⼒。 

- Crouch Speed：蹲伏前進的速度為 Max Speed 的幾倍，其值範圍為 0 ~ 1，若

為 1，表⽰速度與前進速度相同。 

- Air Control：跳躍或掉落時，角⾊在空中是否可控制。 



- What Is Ground：指定哪些層級的遊戲物件可做為地⾯，讓角⾊判定為「落
地」。 

• CollisionSlider：在遊戲畫⾯上看不⾒的碰撞區塊。 

• CratePink：原⾊為粉紅⾊的可推動箱⼦。 

• ExtentsLeft：⽤於限制左側⾏動範圍的垂直牆壁。 

• ExtentsRight：⽤於限制右側⾏動範圍的垂直牆壁。 

• Killzone：在遊戲畫⾯上看不⾒的死亡區域碰撞區塊，主要⽤來放在地板之下，

當角⾊掉落接觸到之後，代表角⾊死亡，場景將⽴即重新載入。 

• Platform04x01：4 x 1  ⼤⼩的平台。 

• Platform08x01：8 x 1  ⼤⼩的平台。 

• Platform12x01：12 x 1  ⼤⼩的平台。 

• Platform16x01：16 x 1  ⼤⼩的平台。 

• Platform36x01：36 x 1  ⼤⼩的平台。 

• PlatformRamp：帶有斜坡的平台。 



2. Cameras 
匯入 Cameras 資源包裡除了 Camera 相關的資源之外，還包含了相關的 
CrossPlatformInput 的資源必須同時匯入。 

在 Standard Assets > Cameras > Prefabs 資料夾裡，有⽴即可⽤的預置元件，直接
拖拉到場景中，配置鏡頭跟隨的⽬標物件，或將⽬標物件的 Tag 設置為 Player，就

能提供常⾒的攝影鏡頭⾏為： 

• CctvCamera：類似於監視器鏡頭，鏡頭放置在固定點，跟隨⽬標物件轉動。 

• FreeLookCameraRig：跟隨⽬標物件移動的鏡頭，且可透過滑鼠或⼿勢（⼿機）

轉動視角。 

• HandheldCamera：以⽬標物件模擬⼿持物品般拉近畫⾯並⾃然晃動。 

• MultipurposeCameraRig：跟隨⽬標物件移動和轉動的鏡頭。 



3. Characters 
匯入 Characters 資源包裡除了 Characters 相關的資源之外，還包含了相關的 
CrossPlatformInput 以及 Utility 的資源必須同時匯入。 

在 Standard Assets > FirstPersonCharacter > Prefabs、Standard Assets > 
RollerBall > Prefabs 以及 Standard Assets > ThirdPersonCharacter > Prefabs 資料

夾裡，都提供有⽴即可⽤的預置元件，直接拖拉到場景中，就能進⾏不同種類的角
⾊控制： 

• FirstPersonCharacter：第⼀⼈稱角⾊控制。 

- FPSController：使⽤ Character Controller 組件為主的第⼀⼈稱角⾊控制。 

- RigidBodyFPSController：以 Rigidbody 組件的控制為主的第⼀⼈稱角⾊。 

• RollerBall：以鏡頭視角為主要控制⽅向，並受⼒學影響的滾動球體角⾊控制。 

• ThirdPersonCharacter： 

- ThirdPersonController：以鏡頭視角為主要控制⽅向的第三⼈稱角⾊控制。 

- AIThirdPersonController：配合 Unity 的 Navigation 使其具備 AI 尋徑功能的
第三⼈稱角⾊控制。 



4. Environment 
匯入 Enviroment 資源包裡除了 Environment 相關的資源之外，還包含了相關的 
CrossPlatformInput 以及 Utility 的資源必須同時匯入。 

主要提供配合 Unity 的 Terrain 系統來製作地形環境所需要的資源，如樹⽊、草、
地表貼圖以及⽔⾯效果。 



5. ParticleSystems 
匯入 Enviroment 資源包裡除了 Environment 相關的資源之外，還包含了相關的 
CrossPlatformInput 以及 Utility 的資源必須同時匯入。 

在 Standard Assets > ParticleSystems > Prefabs 資料夾裡，有⽴即可⽤的預置元
件，直接拖拉到場景中，就能呈現其粒⼦特效，包含有爆炸、⽕、沙塵、⽔流、煙

⽕、⽕光等等特效。 



6. Prototyping 
匯入 Prototyping 資源包裡除了 Prototyping 相關的資源之外，還包含了相關的 
CrossPlatformInput 以及 Utility 的資源必須同時匯入。 

在 Standard Assets > Prototyping > Prefabs 資料夾裡，有⽴即可⽤的預置元件，
直接拖拉到場景中，就可以開始使⽤這些原型物件編輯場景原型，包含有⽅塊、⽴

⽅體、地板、房屋、連接物、撿取物、柱⼦、平台、斜坡、階梯、牆壁等可供使⽤。



7. Utility 
匯入 Utility 資源包裡除了 Utility 相關的資源之外，還包含了相關的 
CrossPlatformInput 的資源必須同時匯入。 

從選單列的 Component > Scripts 選單或者 Standard Assets > Utility 資料夾，可
找到能賦予遊戲物件的實⽤功能： 

• ActivateTrigger：使物件被觸發時，可對⽬標物件執⾏觸發、開關遊戲物件、啟
動、執⾏動畫、替換遊戲物件等功能。 

• AlphaButtonClickMask：遮蔽 UI 按鈕的透明區域，使透明區域被點擊時不會觸

發按鈕功能。 

• AutoMoveAndRotate：使遊戲物件依照指定值⾃動移動或旋轉。 

• DragRigidbody：使具備 Rigidbody 的遊戲物件可被拖拉。 

• EventSystemChecker：檢查 EventSystem 是否存在，不存在就會⾃動產⽣。 

• FollowTarget：依照指定的偏移值，跟隨⽬標物件。 

• FPSCounter：在 UI 的 Text 顯⽰ FPS 值。 

• ObjectResetter：提供 DelayedReset 功能，使遊戲物件能夠被要求在指定時間後

重置。 

• ParticleSystemDestroyer：指定時間範圍之後清除粒⼦系統。 



• PlatformSpecificContent：⽤來設置指定平台使⽤到的遊戲物件和組件有哪些，
並依照當前平台⾃訂開啟或關閉。 

• SimpleMouseRotator：使物件前⽅（Z 軸⽅向）跟隨滑鼠指標轉動。 

• TimedObjectActivator：定時開、關、銷毀指定遊戲物件或重新載入場景。 

• TimedObjectDestructor：定時銷毀遊戲物件。 

• WaypointCircuit：使⽤遊戲物件來設定航點。 

• WaypointProgressTracker：處理航點進度的追蹤器。 

標準資源包不會⾃動更新： 
在建⽴新專案的時候，可以選擇要包含哪些標準資源，Unity 會從安裝資料夾將所選擇
的資源複製到新的專案資料夾裡。因此，在你更新 Unity 編輯器到新版本時，原本在專

案中已經匯入的標準資源並不會更新，所以，你必須⼿動更新它們。 

新版本的標準資源包可能會與現存安裝的表現不同（例如，效能或品質的原因）。使⽤

新版本可能會使專案外觀或⾏為變得不同，可能需要重新調整參數。在決定重新安裝前，
應該要先確認 Unity  發佈說明的資源包內容。 



IX.主要⼯作視窗 
1. Project 視窗 

在這個視窗，能夠訪問和管理專案中的資源。 

左側的⾯板以層次列表來顯⽰專案的資料夾結構。當點擊其中的資料夾，它的內
容會顯⽰在右側的⾯板。可以透過點擊⼩三角形來展開或收合其內容的任何巢狀

資料夾。按住 Alt 按鍵，能夠遞歸的展開或收合整個巢狀資料夾。 

右側⾯板顯⽰的個別資源以圖標來指⽰它們的類型（如程式腳本、材質、⼦資料
夾等）。在⾯板右下⽅可使⽤滑條來調整圖標⼤⼩。如果滑條移動到最左邊，將

會以層次列表的顯⽰來取代圖標。滑條左側的空⽩處顯⽰⽬前所選擇的東西，包
含它們的完整路徑。 

在專案結構列表之上的「Favorites」區塊，你可以保持經常使⽤的項⽬以⽅便訪
問。你可以將專案結構列表拖拉到 Favorites，還可以儲存搜尋查詢到這裡。 



⾯板上⽅是個「導航標記路徑」，顯⽰⽬前正在查看的資料夾路徑。可以點擊路
徑上的個別元素來輕鬆的在資料夾層次中瀏覽。搜尋時，此欄會更改為顯⽰正在

搜尋的區域（資源根⽬錄、所選資料夾或 Asset Store）以及以斜線分隔顯⽰在 
Asset Store 中可⽤的免費和付費資源的數量。如果不需要，在 Unity 的 
Preferences 視窗的 General 區塊有個選項能夠關閉顯⽰ Asset Store 符合搜尋的數

量。 

視窗頂部是瀏覽器的⼯具列。 

位於⼯具列左邊，Create 選單讓你添加新的資源和資料夾到⽬前的資料夾中。右
邊⼀系列的⼯具則是讓你能夠在專案中搜尋資源。 

視窗選單提供切換選項讓你切換 Project 視窗為⼀個⾯板的版本，只會有層次結構
列表，⽽沒有圖標外觀。鎖頭圖標以類似 Inspector 的⽅式讓你凍結⽬前視窗的內
容（避免它們被其他地⽅的事件所改變）。 



• 搜尋 

瀏覽器上有個強⼤的功能，特別有⽤於在⼤專案或陌⽣的專案中找出資源。

基本上會根據在搜尋欄位輸入的⽂字過濾資源。 

如果提供更多個搜尋字詞，就會縮⼩搜尋範圍，所以，如果你輸入「coastal 
scene」，將只會使⽤「coastal」和「scene」這兩個名稱來尋找資源（字詞會 

AND 在⼀起）。 

搜尋欄位右邊三個按鈕。第⼀個讓你能夠根據其類型進⼀步過濾搜尋找到的
資源。 



第⼆個則依據它們的標籤過濾（可以為資源在 Inspector 視窗設置）。由於標
籤數量可能非常多，所以標籤選單有⾃⼰的搜尋過濾欄位。 

注意：過濾器的運作是使⽤搜尋⽂字透過添加額外的字詞來實現。在字詞開
頭使⽤「t:」來過濾指定資源類型，使⽤「l:」來指定標籤。如果你很清楚你

想要尋找什麼，可以直接在搜尋欄位輸入這些字詞，⽽不使⽤選單。還可以
⼀次搜尋多個類型或標籤。添加幾個類型將擴展搜尋包含所有指定的類型（類
型將 OR 在⼀起）。添加多個標籤將使搜尋縮⼩到具有所指定標籤的項⽬（標

籤將被 AND）。 

最後⼀個按鈕則是將所搜尋到的列表添加到 Favourites 區。 



• 搜尋 Asset Store 

Project 視窗瀏覽器的搜尋也可以從 Asset Store 搜尋可⽤的資源。如果從「導

航標記條」選擇 Asset Store，所有符合查詢的免費和付費項⽬都會被顯⽰出
來。透過類型和標籤的搜尋⽅式與 Unity 專案中相同。⾸先會針對資源名稱確
認來搜尋，然後依照資源包名稱、資源包標籤和資源介紹的順序來檢查（因

此，名稱包含搜尋條件的排名會⾼於其說明中有相同字詞的物品）。 

如果從所找到的列表選擇⼀個項⽬，詳細訊息將會與購買和／或下載選項顯
⽰在 Inspector 視窗。有些資源可以提供預覽，因此你可以在購買之前旋轉 

3D 模型查看。Inspector 視窗也會提供 Asset Store 視窗的相關按鈕，以利查
看其它詳細訊息。 



2. Scene 視窗 

在這個視窗是與你所創建視窗互動的視窗。你將使⽤這個視窗選擇和放置風景、
角⾊、攝影機、光源和所有其它類型的遊戲物件。 

• Scene Gizom 

在 Scene 視窗右上角的 Scene Gizmo，顯⽰ Scene 視窗攝影機⽬前的⽅向，

並讓你能夠快速的修改觀察角度和投影模式。 

Scene Gizmo 在⽴⽅體的每個邊都有個錐形臂，被標⽰了 X、Y 和 Z。點擊
任何錐形軸臂將場景視野攝影機貼齊到其所代表的軸（例如上視圖、左視圖

和前視圖）。還可以右鍵點擊⽴⽅體顯⽰視角選單。如果要返回預設視角，
可右鍵點擊 Scene Gizmo，然後點擊 Free。 

還可以切換透視的開和關。此切換可以使場景視窗在透視（Perspective）和

正交（Orthographic - 有時也稱為等距 Isometric）之間切換其投影模式。要
這麼做，可以點擊在 Scene Gizmo 中間的⽴⽅體或其下的⽂字來切換。 



如果你的場景視窗處於怪異的視角（上下顛倒或者某個混亂角度），按住 
Shift 並點擊 Scene Gizmo 中間的⽴⽅體，以返回場景側⾯稍微上⽅的透視

（Perspective）視角。 

點擊 Scene Gizmo 右上角的鎖頭，可禁⽤或啟⽤場景的旋轉。⼀旦場景旋轉
被關閉，拖拉滑鼠右鍵將會平移視野，⽽不再是旋轉視野。 

注意！2D 模式下，Scene Gizmo 不會顯⽰，因為此時的視野只會垂直於 XY 
平⾯。 

• ⽅向鍵移動 

你可以使⽤⽅向鍵在場景中移動，就像「⾛過」⼀樣。上下鍵使攝影機依據
所⾯對的⽅向前進和後退。左右鍵橫向平移視野。按住 Shift 鍵可以更快地

移動。 



• ⼿⼯具：當⼿⼯具被選擇時（快捷鍵：Q），可以使⽤以下的滑鼠控制。 

- 移動：拖動攝影機移動視野。 

- 繞⾏：按住 Alt 和滑鼠左鍵拖動，攝影機將圍繞⽬前的⽀點繞⾏移動。這
在 2D 模式無法使⽤。 

- 縮放：按住 Alt 拖動和滑鼠右鍵拖動，可縮放 Scene 視窗。 

按住 Shift 鍵可提⾼移動和縮放的速度。 

• ⾶越模式 

使⽤⾶越模式來透過使⽤第⼀⼈稱⾶⾏的⽅式瀏覽 Scene 視窗內容，類似於

在許多遊戲中瀏覽的⽅式。 

1. 按著滑鼠右鍵。 

2. 使⽤滑鼠移動視野，W、A、S、D 按鍵來向前、後、左、右移動，Q 和 E 

鍵可上下移動。 

3. 按住 Shift 可移動得更快。 

⾶越模式是為透視模式⽽設計的，在正交模式下，按住滑鼠右鍵會使攝影機
繞⾏轉動。 

注意：在 2D 模式下，⾶越模式沒有作⽤，此時按著滑鼠右鍵只能拖拉滑鼠

平移視野。 

• 視野集中在遊戲物件上 

要將 Scene 視窗中⼼對準遊戲物件，先在 Hierarchy 視窗選擇該遊戲物件，
然後移動滑鼠到 Scene 視窗上按下 F 鍵。這個功能也能在選單列的 Edit > 
Frame Selected 找到。即使遊戲物件正在移動，要將視野鎖住到遊戲物件，

請按 Shift + F，此功能也可在 Edit > Lock View to Selected 找到。 



3. Game 視窗 

Game 視窗的內容是從遊戲中的攝影機所呈現的。它代表你最終所要發佈的遊戲。
你會需要使⽤⼀個或多個攝影機來控制玩家玩你的遊戲時所實際看到的內容。 

• 播放模式 

使⽤⼯具列的按鈕來控制編輯器播放模式，並查看你發佈的遊戲如何運⾏。
在播放模式下，所做的任何改變都是暫時的，當你結束播放模式都將被重置。

編輯器會稍微變暗來提⽰你。 

• 控制列 



- Display：如果場景中有多台攝影機，可點擊此處從攝影機列表選擇。預設
是 Display 1。（可以在 Camera 組件的 Target Display 下拉選單指定）。 

- Aspect：選擇不同的值去測試你的遊戲在使⽤不同長寬比的顯⽰器上看起

來會是怎麼樣。預設是 Free Aspect。 

- Scale 滑條：向右滑動以更詳細的放⼤並查看遊戲畫⾯的區域。還可讓你縮

⼩來查看設備解析度⾼於 Game 視窗⼤⼩的整個畫⾯。你也可以在遊戲停
⽌或暫停時使⽤滑鼠滾輪和中鍵來執⾏此操作。 

- Maximize On Play：當你進入播放模式時，使 Game 視窗最⼤化來以全螢

幕預覽（編輯器視窗的 100%）。 

- Mute Audio：當進入播放模式時，使⽤此功能可使任何遊戲中的聲⾳變為

靜⾳。 

- Stats：可顯⽰統計訊息疊加在 Game 視窗之上，其中包含遊戲聲⾳和圖像
的渲染統計訊息。這對於在播放模式下監看遊戲的效能非常有⽤。 

- Gizmos：切換顯⽰可⾒的 Gizmo，要在播放模式中只看到某些類型的 
Gizmo，可點擊旁邊的下拉箭頭，只勾選想要看到的 Gizmo 類型。 

• 進階選項 

在 Game 標籤上點擊右鍵可顯⽰ Game 視窗的進階選項。 

- Warn if No Cameras Rendering：此項⽬預設是開啟的，如果沒有攝影機

正在渲染到螢幕上，則會顯⽰警告。這對於診斷諸如意外刪除或停⽤攝影
機的問題非常有⽤。保持啟⽤，除非你故意不使⽤攝影機來渲染遊戲。 

- Clear Every Frame in Edit Mode：此項⽬預設是開啟的。當遊戲未播放
時，會導致遊戲視窗每幀都被清除。這可以防⽌在配置遊戲時造成拖尾效
應。 保持啟⽤，除非你在非播放模式下，正依賴於前⼀幀的內容。 



4. Hierarchy 視窗 

Hierarchy 是包含當前場景中每個遊戲物件的列表。其中⼀些直接是資源檔案（如 
3D 模型）的實例，⽽其它是 Prefabs 的實例，它們是組成⼤部分遊戲的⾃定義物

件。當場景中添加和刪除物件時，它們也將從 Hierarchy 視窗顯⽰和消失。 

預設的情況下，物件按照他們被產⽣的順序列於 Hierarchy 視窗中。可以通過向
上或向下拖動物件或使其成為「⼦」或「⽗」物件來重新排序。 

• Parenting 

Unity 使⽤⼀種叫做 Parenting 的概念。當您創建⼀個物件群組時，最上層的
物件或場景稱為「⽗物件」，所有被群組於其下的物件都稱為「⼦物件」。 
還可以創建巢狀的⽗⼦物件。 



點擊⽗物件的下拉箭頭（在其名稱的左側）顯⽰或隱藏其⼦項。按住 Alt 鍵同
時點擊下拉箭頭以切換⽗項的所有⼦物件的顯⽰或隱藏。 

• 製作⼦物件 

要使任何物件成為另⼀個物件的「⼦項」，在 Hierarchy 視窗將所需的⼦物件
拖放到預期的⽗物件上。 

還可以將物件拖放到其它物件旁，使其成為「兄弟姐妹」- 即同⼀⽗物件下的
⼦物件。將物件拖動到現有物件的上⽅或下⽅，直到出現⼀條⽔平的藍線，

並將其放在現有物件旁邊。 

⼦物件會繼承⽗物件的移動和旋轉。 



• 字母數字排序 

Hierarchy 視窗中，物件的順序可以更改為字母數字順序。在選單列選擇 Edit 

> Preferences 開啟 Preferences 視窗。 勾選 Enable Alpha Numeric Sorting。 

當勾選後， Hierarchy 視窗的右上⽅會出現⼀個圖標，使你能夠在 Transform 
排序（預設值）或字母排序之間進⾏切換。 



5. Inspector 視窗 
Unity 編輯器中的專案，是由多個包含程式腳本、聲⾳、網格和其它圖像元素的遊
戲物件所組成。 Inspector 視窗顯⽰關於⽬前所選取遊戲物件的詳細訊息，包括所

有連接的組件及其屬性，並允許修改場景中遊戲物件的功能。。 

• 檢閱遊戲物件 

在 Unity 編輯器中使⽤ Inspector 視窗去查看和編輯幾乎所有東西的屬性和設

置，包括物理遊戲項⽬，如遊戲物件、資源和材質等，以及編輯器中的設置
和喜好設定。 

當你在 Hierarchy 或 Scene 視窗中選擇

⼀個遊戲物件時，Inspector 視窗將顯⽰
該遊戲物件的所有組件和材質的屬性。

使⽤ Inspector 視窗編輯這些組件和材質
的設置。 

右圖顯⽰選擇 Main Camera 遊戲物件的 

Inspector 視窗。 除了遊戲物件的位置
（Position）、旋轉（Rotation）和縮放

（Scale）值之外，還可以編輯 Main 
Camera 的所有屬性。 



• 檢閱程式腳本變數 

當遊戲物件附加了⾃定義程式腳本組件時，Inspector 視窗將顯⽰該程式腳本
的公開變數。可以使⽤與設置編輯器內建組件的相同⽅式來編輯這些變數的

設置。這意味著你可以輕鬆地設置在程式腳本中的參數和預設值，⽽無需修
改程式碼。 



• 檢閱資源 

在 Project 視窗中選擇資源時，Inspector 視窗將會顯⽰與資源被匯入以及⽤

於運⾏時相關的設置。 

每種類型的資源都有不同的設置選擇。 以下圖⽚⽰範 Inspector 視窗顯⽰其它
資源類型匯入設置的⼀些範例： 

 



X.遊戲場景 
遊戲場景包含了環境以及你的遊戲選單。將每個個別的場景檔案視為⼀個個
別的關卡。在每個場景中，放置你的環境、障礙物和裝飾品，⼤體上設計和
構建你的遊戲。 

創建新的 Unity 專案時，場景視窗將顯⽰⼀個新的場景。此場景未命名，也
未儲存。除了攝影機（稱為 Main Camera）和光源（稱為 Directional 
Light）外，場景是空的。 

1. 儲存場景 
要儲存正在編輯的場景，在選單列中選擇 File > Save Scene，或者按 Ctrl + S
（Windows）或 Cmd + S（masOS）。 



Unity 將場景做為資源儲存在專案的 Assets 資料夾中。這意味著它們會與其餘資
源⼀起出現在 Project 視窗中。 

2. 開啟場景 
要在 Unity 中打開場景，請在 Project 視窗中雙擊「場景資源」。 你必須在 Unity 
中開啟來編輯它。 

如果當前的場景包含未儲存的變更，Unity 會詢問是要儲存還是丟棄更改。 



XI.多場景編輯 
多場景編輯讓你能夠在編輯器中同時打開多個場景，並使運⾏時更容易管理
場景。 

在編輯器中打開多個場景的功能使你能夠創建⼤型串流世界，並在場景編輯
協作時改善⼯作流程。 

1. 編輯器操作 
要開啟新場景並將其添加到 Hierarchy 視窗中的⽬前場景列表中，可在場景資源
按滑鼠右鍵選擇 Open Scene Additive，或者將⼀個或多個場景從 Project 視窗拖

拉到 Hierarchy 視窗中。 

當你在編輯器中打開多個場景時，每個場景的內容將個別的顯⽰在 Hierarchy 視

窗中。每個場景的內容會出現在顯⽰場景名稱和儲存狀態的場景分隔欄下⽅。 

 



當存在於 Hierarchy 視窗中時，場景可以載入或卸載以顯⽰或隱藏每個場景中所包
含的遊戲物件。這與從 Hierarchy 視窗中添加和刪除它們不同。 

場景分隔欄可以在 Hierarchy 視窗中折疊場景的內容，如果你載入了⼤量的場景，
這會有助於導覽。 

當處理多個場景時，每個被修改的場景都需要儲存其變更，因此可能有多個未儲存

的場景同時開啟。未儲存的場景將在場景分隔欄中的名稱旁邊顯⽰⼀個星號。 

每個場景可以通過分隔欄的選單個別儲存。從 File 選單選擇 Save Sene 或者按 Ctrl 
+ S 可以儲存所有開啟場景的變更。 

場景分隔欄的選單可以讓你對所選擇的場景執⾏其它的⾏為。 

• 已載入場景的場景分隔欄選單： 

- Set Active Scene：這讓你指定哪個場景能夠建⽴／實例化新的遊戲物件。始
終要有⼀個場景必須被標記為 Active Scene。 

- Save Scene：只儲存變更到所選擇的場景。 

- Save Scene As：將所選場景（以及⽬前的任何變更）儲存為新的場景資源。 

- Save All：儲存所有場景的變更。 



- Unload Scene：卸載場景，但是將場景保留在 Hierarchy 視窗。 

- Remove Scene：卸載並從 Hierarchy 視窗移除場景。 

- Select Scene Asset：在 Project 視窗選擇場景的資源。 

- GameObject：提供⼦選單讓你能夠在所選擇的場景建⽴遊戲物件。此選單對
應於 Unity 主要的 GameObject 選單。 

• 未載入場景的場景分隔欄選單： 

- Load Scene：載入場景內容。 

- Remove Scene：從 Hierarchy 視窗移除場景。 

- Select Scene Asset：在 Project 視窗選擇場景的資源。 



2. 播放模式 
在播放模式中，在 Hierarchy 中有多個場景，將會顯⽰⼀個名為 
DontDestroyOnLoad 的附加場景。 

在 Unity 5.3 之前，任何你在播放模式中標記為 DontDestroyOnLoad 的物件仍將顯
⽰在 Hierarchy 視窗中。這些物件不被視為任何場景的⼀部分，但是 Unity 仍然顯
⽰其物件，為了讓你檢查它們，這些物件現在顯⽰為特殊的 DontDestroyOnLoad 

場景的⼀部分。 

你無權存取 DontDestroyOnLoad 場景，並且在運⾏時不可⽤。 

3. 場景的特定設置 
有⼀些設置是特定儲存於每個場景中：RenderSettings 和 LightmapSettings（可在 

Lighting 視窗找到）、NavMesh 設置、在 Occlusion Culling 視窗的場景設置。 

其⼯作原理是，每個場景會管理它⾃⼰的設置，並且只有與該場景相關的設置才會

儲存在場景檔案中。 

如果打開多個場景，則⽤於渲染和 NavMesh 的設置來⾃ Active Scene。這意味著
如果要更改場景的設置，則必須只打開⼀個場景並更改設置，或者使有問題的場景

成為 Active Scene 並更改其設置。 

當你在編輯器中或運⾏時切換 Active Scene 時，將會套⽤新場景中的所有設置並替

換所有以前的設置。 

4. 提⽰和技巧 
透過按住 Alt 鍵拖拉場景添加到 Hierarchy 視窗，能夠保持場景的卸載狀態，這
樣，就可以隨時根據需要載入場景。 

新場景能夠使⽤ Project 視窗的 Create 建⽴，建⽴後的內容將會包含預設的遊戲物
件。 



要避免每次重新開啟 Unity 就必須設置 Hierarchy 視窗或想要簡單的儲存不同的設
置，可以使⽤ EditorSceneManager.GetSceneManagerSetup 來獲得 SceneSetup 物

件列表來描述⽬前的設定。可以將其序列化到 ScriptableObject 或伴隨⼀些其它你
想要儲存關於場景設置的其它任何資訊。要恢復 Hierarchy，只需重新創建 
SceneSetups 列表，使⽤ EditorSceneManager.RestoreSceneManagerSetup。 

在運⾏時獲取載入場景的列表，只需使⽤取得 sceneCount 並使⽤ GetSceneAt 輪詢
即可。 

你可以透過 GameObject.scene 得知遊戲物件屬於哪個場景，並可使⽤ 
SceneManager.MoveGameObjectToScene 將遊戲物件移動到另⼀個場景。 

建議避免使⽤ DontDestroyOnLoad 來保存想在場景之間⽣存的管理器遊戲物件。 

⽽是創建⼀個包含所有管理器的管理器場景，並使⽤ SceneManager.LoadScene
（最後參數為 LoadSceneMode.Additive）和SceneManager.UnloadScene 來管理

遊戲進度。 



XII.遊戲物件與組件概念 
1. 遊戲物件 GameObject 

GameObject 在 Unity 編輯器中是最重要的概念。 

遊戲中的每個物件都是 GameObject，從角⾊和收藏品到光源、攝影機和特效。然

⽽，GameObject 不能⾃⼰做任何事情; 你需要給它屬性，才能成為⼀個角⾊、環
境或特殊效果。 

為了給予 GameObject 所需要的屬性變成⼀個光源、⼀棵樹、⼀個攝影機，必須

為其添加組件。根據要創建的物件種類，你可以向 GameObject 添加不同的組件
組合。 

可以將 GameObject 視為⼀個空的烹飪鍋，組件可以做為組合遊戲食譜的不同原
料。Unity 有許多不同的內建組件類型，你也可以使⽤ Unity Scripting API 去製

作⾃⼰的組件。 

GameObject 是 Unity 中表現角⾊、道具和風景的基本物件。它們本身並沒有太多
的實現，⽽是做為實現實際功能的組件的容器。 

例如，通過將 Light 組件附加到 GameObject 來創建光源物件。 



實體⽴⽅體物件具有 Mesh Filter 和 Mesh Renderer 組件，⽤於繪製⽴⽅體的表
⾯，以及⼀個 Box Collider 組件，⽤於在物理條件裡表⽰物件的實體體積。 

GameObject 始終具有附加的 Transform 組件（以表⽰位置和⽅向），並且不能
移除它。賦予物件功能的其它組件，可以從編輯器的 Component 選單或是從程式
腳本來添加。在 GameObject > 3D Object 選單中，還有許多有⽤的預先構建的物

件（原始形狀、攝影機等）可使⽤。 

2. 組件 Component 介紹 
GameObject 包含多個 Component。 

你可以透過在 Inspector 視窗查看新的 GameObject 看到 Transform 組件： 

(1) 在 Unity 編輯器中的任何專案中打開任何場景。 

(2)創建⼀個新的 GameObject（選單：GameObject > Create Empty）。 

(3)新的 GameObject 被預選，Inspector 視窗顯⽰其 Transform 組件。（如果沒
有預選，請點擊它查看其 Inspector 視窗。） 

請注意，新的空的 GameObject 包含其名稱「GameObject」、Tag「Untagged」
和 Layer「Default」。還包含⼀個 Transform 組件。 

• Transform 組件 

在編輯器中創建沒有 Transform 組件的 GameObject 是不可能的。該組件定義 
GameObject 在遊戲世界和 Scene 視窗中的位置、旋轉和縮放。 

Transfrom 組件還實現了⼀個稱為 Parenting 的概念，這是使⽤ GameObject 的
關鍵部分。 

• 其它組件 
Transform 組件對所有 GameObject 至關重要，因此每個 GameObject 都有⼀
個，但 GameObject 也可以包含其它組件。 



預設情況下，每個場景都有⼀個 Main Camera 的 GameObject。它具備幾個組
件（可以在開啟的場景中選擇它，並在 Inspector 查看。） 

在 Inspector 視窗查看 Main Camera 的 GameObject，可以看到它包含其他組
件。具體來說有 Camera、GUILayer、Flare Layer 和 Audio Listener 組件。 所

有這些組件都為此 GameObject 提供了功能。 

Rigidbody、Collider、Particle System、和 Audio 都是各種可以添加到 
GameObject 的組件。 



XIII.使⽤組件 Component 
Component 是遊戲中物件和⾏為的核⼼。它們是每個 GameObject 的功能
塊。 

GameObject 是許多不同組件的容器。預設情況下，所有 GameObject 都會
⾃動有⼀個 Transform Component。這是因為 Transform 主宰 
GameObject 所在的位置，以及如何旋轉和縮放。 沒有 Transform 
Component，GameObject 在遊戲世界上不會有位置。 

現在試著點擊選單列的 GameObject > Create Empty 建⽴⼀個空的 
GameObject。選擇新的 GameObject，然後查看 Inspector 視窗。 

請記住，你可以隨時使⽤ Inspector 視窗來查看哪些 Component 附加到所
選的 GameObject 上。隨著添加和刪除 Component，Inspector 視窗將始終
顯⽰當前附加的 Component。你將會使⽤ Inspector 視窗去更改任何 
Component（包括 Script）的所有屬性。 

1. 添加 Component 
你可以通過 Component 選單將 Component 添加到所選的 GameObject。 

我們現在將嘗試通過在剛剛創建的空的 GameObject 中添加⼀個 Rigidbody。選

擇它，然後從選單中選擇 Component > Physics > Rigidbody。 

當你這樣做時，你會看到 Rigidbody 的屬性出現在 Inspector 視窗中。 如果你仍
然選擇空的 GameObject，則按 Play 鍵查看⼀下。 



你會注意到，添加了 Rigidbody 給空的 GameObject，GameObject 的 
Transform 的 Y 軸位置開始往下降，這是因為 Unity 的物理引擎導致 

GameObject 受重⼒影響⽽掉落。 

另⼀個選項是使⽤ Component 瀏覽器，可以在物件的 Inspector 視窗使⽤ Add 
Component 按鈕來啟⽤它。 

這個瀏覽器讓你能夠按照類別⽅便地導覽 Component，並且還具有可按名稱查
找 Component 的搜尋欄。 



你可以將任何數量或 Component 的組合附加到單個 GameObject。有些 
Component 能夠與其它 Component 結合使⽤。例如，Rigidbody 與任何 

Collider 共同運作。Rigidbody 通過 NVIDIA PhysX 物理引擎控制 Transform，
Collider 允許 Rigidbody 與其它 Collider 進⾏碰撞和互動。 

如果想了解有關使⽤特定 Component 的更多訊息，可以在 Inspector 視窗點擊 

Component 名稱上的⼩書圖標來查看 Unity ⼿冊中的 Component 說明⾴⾯。 

2. 編輯 Component 
Component 的⼀個重要⽅⾯是靈活性。當你將 Component 附加到 GameObject 

時，Compoennt 中有不同的值或屬性，可以在構建遊戲時於編輯器中進⾏調
整，或者在運⾏遊戲時透過程式進⾏調整。屬性有兩種主要種類：值（Value) 和
參考（Reference）。 

如下圖所⽰。它是⼀個空的 GameObject 帶有 Audio Source Component。在 
Inspector 視窗中的 Audio Source 的所有的值，都是預設值。 



這個 Component 包含 Reference 屬性和 Value 屬性。Audio Clip 是 Reference 
屬性。當此 Audio Source 開始播放時，將嘗試播放 Audio Clip 屬性中所參考到

的聲⾳檔案。 如果沒有參考，則會發⽣錯誤，因為沒有聲⾳可以播放。你必須
在 Inspector 視窗中參考該檔案。這個步驟很簡單，將聲⾳檔案從 Project 視窗
拖到該 Reference 屬性，或是使⽤物件選擇器（Object Selector）。 

Component 可以包含對任何其它類型的 Component、GameObject 或資源的參
考。 

Audio Clip 以外的其餘屬性都是 Value 屬性。這些可以在 Inspector 視窗中直接
調整。這些 Value 屬性有切換（Toggle）、數值、下拉選單，Value 屬性也可以
是⽂字字串、顏⾊、曲線和其它類型。 



3. Component 環境選單指令 
Component 的環境選單（Context Menu）有許多有⽤的指令。 

Inspector 視窗的 Component ⾯板右上角的「齒輪」圖標也可以獲得相同的指
令。 

• Reset：可恢復 Component 屬性到最近的編輯期之前所具有的值。 

• Remove：可⽤於移除不再需要連接到 GameObject 的 Component。請注
意，有⼀些相互依賴的 Component（例如，Hing Joint 僅在 Rigidbody 被賦

予時才起作⽤）︔如果嘗試移除其它相依賴的 Component，將彈出警告消
息。 

• Move Up／Down：使⽤上移（Move Up）和下移（Move Down）指令來重
新排列 Inspector 視窗中 GameObject 的 Component 順序。 

• Copy／Paste：Copy Component 指令儲存 Component 的類型和當前屬性設

置。然後可以使⽤ Paste Component Values 將這些貼到相同類型的另⼀個 
Component。還可以通過使⽤ Paste Component As New 將物件複製的值創

建為新的 Component。 



4. 測試屬性 
當遊戲處於播放模式時，可以隨意更改任何 GameObject 在 Inspector 視窗中的
屬性。例如，你可能想要嘗試不同的跳躍⾼度。 

如果你在程式腳本中創建 Jump Height 屬性，可以在進入播放模式時，更改其
值，然後按跳躍按鈕查看會發⽣什麼。然後，不要退出播放模式，可以再次更改
它，並在幾秒鐘內查看結果。當退出播放模式時，屬性將恢復為其播放模式前的

值，因此你不會丟失任何東西。 

這個⼯作流程提供了測試、調整和改善遊戲的強⼤能⼒，⽽無需重複循環的投入

⼤量時間。 



XIV.轉換組件 Transform 簡介 
Transform 組件決定場景中每個物件的位置，旋轉和縮放。每個 
GameObject 都有⼀個 Transform。 

• 屬性： 

- Position：X、Y 和 Z 座標變換的位置。 

- Rotation：圍繞 X、Y 和 Z 軸變換的旋轉，以角度為單位。 

- Scale：沿著 X、Y 和 Z 軸變換的比例⼤⼩。值 1 是原始的⼤⼩（物件
被匯入時的⼤⼩）。 

Transform 的位置、旋轉和縮放值相對於⽗項 Transform 來測量。 如果 
Transform 沒有⽗項，則其屬性是使⽤世界空間來測量的。 



XV.編寫腳本建⽴組件 
編寫腳本（或創建 Script）是使⽤ Unity Scripting API 在程式碼中編寫⾃⼰
附加到 Unity 編輯器的功能。 

當你創建⼀個 Script 並將其附加到 GameObject 時，該 Script 就像內建 
Component ⼀樣顯⽰在 GameObject 的 Inspector 視窗中。這是因為當你將
它們儲存在你的專案中時，Script 會成為 Component。 

在技術術語中，將使編譯的任何 Script 做為 Component 的⼀種類型，因此 
Unity 編輯器會將 Script 視為內建的 Component。你定義要在 Inspector 視
窗中顯⽰的 Script 成員，⽽編輯器將執⾏你所編寫的任何功能。 



XVI.解除遊戲物件 
GameObject 可以透過標記為非活動狀態來暫時從場景中移除。這可以在程
式中使⽤ activeSelf 屬性或者在 Inspector 視窗中使⽤啟⽤勾選框來達成。 

• 停⽤ GameObject ⽗項的影響 

當⽗物件被停⽤時，也將覆蓋所以⼦物件上的 activeSelf 設置⽽將其全部停⽤，因此
從該⽗項向下的整個層次結構都將被停⽤。要注意的是，這不會更改⼦物件上的 

activeSelf 屬性的值，因此，⼀旦⽗物件重新啟⽤，它們將返回原本的狀態。這意味著，
你無法透過讀取其 activeSelf 屬性來確定⼦物件⽬前所處的活動狀態。取⽽代之的，
應該使⽤ activeInHierarchy 屬性，該屬性會以⽗項為⾸要。 

Unity 4.0 中引入了這種壓倒性的⾏為。在早期版本中，有⼀個名為 
SetActiveRecursively 的功能可⽤於啟⽤或停⽤給定⽗物件的⼦項。然⽽，這個功能的

作⽤是不⼀樣的，因為每個⼦物件的啟⽤設置都被改變了 - 整個層次結構都會被關閉，
但是⼦物件沒有辦法「記住」原來的狀態。為了避免破壞舊程式碼，
SetActiveRecursively 為了 4.0 ⽽保留在 API 中，但是不推薦使⽤，⽽將來也可能會

移除。在你真正希望改變⼦項的 activeSelf 設置的特殊情況下，可以使⽤類似以下程
式碼： 



XVII.遊戲物件標籤 
Tag 是可以分配給⼀個或多個 GameObject 的參考字。例如，你可以為玩家
控制的角⾊定義「Player」標籤，並為非玩家控制的角⾊定義「Enemy」標
籤。 可以使⽤「Collectable」標籤來定義玩家可以在場景中收集的道具。 

Tag 可以為你程式編寫的⽬的來幫忙識別 GameObject。它們保障你不需要
使⽤拖放的⽅式⼿動將 GameObject 添加到 Script 的公開屬性，從⽽在多個 
GameObject 中使⽤相同的 Script 時節省時間。 

Tag 有⽤於 Collider 控制程式中的觸發器︔它們需要確定玩家是否與敵⼈、
道具或可收藏品進⾏互動。 

可以使⽤ GameObject.FindWithTag() 功能透過設置 Tag 來查找包含你所想
要的 Tag 的任何物件。以下⽰範使⽤ GameObject.FindWithTag()。它將 
respawnPrefab 實例化在具有標籤「Respawn」的 GameObject 的位置： 

 



1. 建⽴新 Tag 
Inspector 視窗在 GameObject 名稱的下⽅顯⽰ Tag 和 Layer 下拉選單。 

要創建新的 Tag，請選擇 Add Tag...。 這將在 Inspector 視窗中打開 Tag 和 
Layer 的管理器。 請注意，Tag ⼀旦被命名，它將不能再重新命名。 

Layer 與 Tag 類似，但⽤於定義 Unity 如何在場景中呈現 GameObject。 

2. 套⽤ Tag 
Inspector 視窗在任何 GameObject 名稱的下⽅顯⽰ Tag 和 Layer 下拉選單，要
將現有 Tag 套⽤於 GameObject，請打開 Tag 下拉菜單，然後選擇要套⽤的標

籤。 GameObject 就會與此 Tag 相關聯。 

• 每個 GameObject 只能配置⼀個 Tag。 

• Unity 包含⼀些內建的 Tag，不會出現在 Tag 管理器中。 

- Untagged 

- Respawn 

- Finish 

- EditorOnly 

- MainCamera 

- Player 

- GameController 



• 可以使⽤任何你喜歡的字詞做為 Tag。甚至可以使⽤短語，但這樣的話，你
可能需要拉寬 Inspector 視窗才能查看到 Tag 的全名。 

3. Tags and Layers 
Tags and Layers 管理器允許你設置 Tags、Sorting Layers 和 Layers。要查看 

Tages and Layers 管理器的話，使⽤編輯器選單的 Edit > Project Settings > 
Tags and Layers。 

• Tags 

可⽤於標識專案中物件的標記值。要添加新的 Tag，請點擊列表右下角的加號

按鈕（+），並為新 Tag 命名。 



請注意，⼀旦命名了 Tag，就無法重新命名。要刪除 Tag，請點擊選取它，然
後點擊列表右下角的減號（ - ）按鈕。 

• Sorting Layers 

與 2D 系統中的 Sprite 圖像結合使⽤時，「Sorting」是指不同 Sprite 的重疊

順序。 

要添加和刪除 Sorting Layers，請使⽤列表右下⽅的加號和減號（+/-）按
鈕。要更改其順序，請拖動每個 Layer 項⽬左側的拉柄。 



 

• Layers 

在整個 Unity 編輯器中使⽤此⽅法來創建共享特定特徵的物件群組。User 

Layer 主要限制諸如射線處理或渲染處理之類的操作，以使它們僅適⽤於相關
物件群組。 在 Tags and Layers 管理器中，前 8 個內建 Layer 是 Unity 預設使

⽤的，因此無法編輯它們。但是，您可以從 8 到 31 個⾃定義 User Layer。 



要從 8 到 31 個⾃定義 User Layer︔可在每個你要使⽤的⽂字欄位中輸入⾃定
義名稱。請注意，你無法添加 Layers 數量，但與 Tags 不同，可以重新命名 

Layer。 



XVIII.靜態遊戲物件 
許多最佳化需要知道物件是否能夠在遊戲進⾏過程中移動。 

關於靜態（即不移動）物件的訊息，在知道它不會被物件位置變化⽽作廢，
通常可以在編輯器中預先計算。 

例如，可以通過將幾個靜態對象合併成稱為批次處理的單⼀個⼤物件來最佳
化渲染。 

GameObject 的 Inspector 視窗右上角有⼀個 Static 勾選框和選單，⽤於通
知 Unity 中各種不同的系統，讓其知道該物件不會移動。可以將物件分別標
記為每個這些系統的靜態物件，因此當沒有獲得好處時，可以選擇不計算物
件的靜態最佳化。 

Everything 和 Nothing 會同時啟⽤或禁⽤所有使⽤它的系統的靜態狀態。 

使⽤到靜態物件的系統有： 

• Lightmapping：提供場景進階的照明。 



• Occluder 和 Occludee：基於來⾃特定攝影機位置的物件可視性進⾏渲染
最佳化。 

• Batching：將多個物件組合成⼀個較⼤物件的渲染最佳化。 

• Navigation：啟動角⾊去判斷場景障礙物的系統。 

• Off-mesh Links：透過 Navigation 系統在場景的不連續區域之間建⽴連
接。 

• Reflection Probe：在各個⽅向捕捉其周圍環境的球形視野。 



XIX.預製元件 Prefab 
通過添加組件並將其屬性設置為適當的值，可以⽅便地在場景中構建 
GameObject。然⽽，如果你有像 NPC、道具或⼀⽚景⾊這樣在場景中多次
重複使⽤的物件，這可能會產⽣問題。 

簡單地複製物件肯定會產⽣副本，但它們都會是獨⽴可編輯的。通常，你想
要的是特定物件的所有實例具有相同的屬性，因此，當你編輯場景中的⼀個
物件時，你不必對所有副本重複進⾏相同的編輯。 

幸運的是，Unity 有⼀個 Prefab 資源類型，可以讓你儲存具備完整組件和屬
性的 GameObject 物件。 

Prefab 可做為讓你能夠在場景中建⽴新的物件實例的模板。對 Prefab 資源
進⾏任何編輯都會⽴即反映到從其⽣成的所有實例中，但也可以單獨覆蓋每
個實例的組件和設置。 

注意：當您將資源檔案（例如 Mesh）拖動到場景中時，它將創建⼀個新的
物件實例，並且所有這些實例都會在原始資源被更改時，也跟隨更改。 然
⽽，雖然它的⾏為表⾯相似，但資源不是 Prefab，所以將無法添加組件或使
⽤以下描述的其它 Prefab 的功能。 

1. 使⽤ Prefab 
你可以透過選擇 Asset > Create Prefab 來創建 Prefab，然後將物件從場景拖動到
剛出現的「空」Prefab 資源上。 

如果之後將不同的 GameObject 拖到 Prefab 上，將會被詢問是否要使⽤新的 
GameObject 替換掉⽬前的內容。 

簡單的將 Prefab 資源從 Project 視窗拖動到 Scene 視窗，然後就會建⽴ Prefab 

的實例。 

做為 Prefab 實例所建⽴的物件將以藍⾊⽂字顯⽰在 Hierarchy 視窗中（⼀般物

件使⽤⿊⾊⽂字顯⽰）。 



如上所述，Prefab 資源本身的變更將反映在所有實例中，但你也可以個別的修改
單獨的實例。這是很有⽤的，比⽅說，當你想要創建幾個類似的 NPC，但想要

引進⼀些變化以使它們更現實。 

當⼀個屬性值被覆蓋時，它會將其名稱標籤在 Inspector 視窗中顯⽰為粗體（當
⼀個完全新的組件被添加到 Prefab 實例中時，它的所有屬性將以粗體顯⽰）。 

你還可以從程式運⾏時創建 Prefab 實例。 

2. 從實例編輯 Prefab 
Prefab 實例的 Inspector 視窗具有不存在於⼀般物件的三個按鈕：Select、

Revert 和 Apply。 

Select 按鈕會在 Project 視窗選擇出該實例來源的 Prefab 資源。這讓你能夠編輯
主要的 Prefab，從⽽更改其所有的實例。 

然⽽，你也可以使⽤ Apply 按鈕將實例中的覆蓋值儲存回原始的 Prefab（由於
顯⽽易⾒的原因，被修改的 Transform 位置和旋轉值會被排除）。 這有效地讓

你能夠通過任何單獨的實例來編輯所有實例（覆蓋值已被改變的除外），並且是
進⾏全體變更非常快捷⽅便的⽅法。 

如果你嘗試覆蓋屬性，但是之後決定使⽤預設值，則可以使⽤ Revert 按鈕將該

實例還原 Prefab 原本的屬性值。 



XX.各種儲存⼯作 
Unity 儲存關於你專案的許多各種類型的訊息，其中有些以不同的⽅式儲存。
這意味著你的⼯作被儲存時，取決於你正在做什麼樣的更改。 

當然，這裡要特別建議你定期儲存，並使⽤版本控制系統（VCS）來保留對
⼯作的增量更改，並讓你能夠去試探並回滾更改，⽽不會對你的⼯作造成任
何損失。 

1. 儲存⽬前場景的更改 

場景更改包括對 Hierarchy 視窗中的任何物件的修改（例如，添加、移動或刪除
遊戲物件），以及更改 Inspector 視窗中層次化遊戲對象的參數。 

要儲存對場景的更改，請從 File 選單中選擇 Save Scene，或者按 Ctrl / Cmd + 
S。這樣可以將⽬前的變更儲存到場景並執⾏ Save Project。 



這意味著，當你執⾏ Save Scene，所有的東西都被儲存了。 

2. 儲存專案範圍的變化 

你可以在 Unity 中進⾏的⼀些在專案範圍內非特定場景的變更。這些設置可以通
過 File 選單中的 Save Project 有別於場景變更來儲存。 

使⽤ Save Project 不會儲存對場景的變更，只會保存專案範圍的變更。 例如，如
果你使⽤臨時場景對 Prefab 進⾏某些變更，則可能希望儲存專案，⽽不希望儲
存被變更的場景。 

使⽤ Save Project 時，儲存的專案範圍變更包含： 

• 所有的專案設置（Project Settings）： 

 執⾏ Save Project 時，將儲存選單裡每個 Project Settings 的所有設置，如⾃
定義輸入軸、使⽤者定義的 Tag 或 Layer 以及物理重⼒強度。 

當儲存專案時，這些設置的變更將儲存到 ProjectSettings 資料夾中： 

- Input：儲存為 InputManager.asset。 



- Tags And Layers：儲存為 TagManager.asset。 

- Audio：儲存為 AudioManager.asset。 

- Time：儲存為 TimeManager.asset。 

- Player：儲存為 ProjectSettings.asset。 

- Physics：儲存為 DynamicsManager.asset。 

- Physics 2D：儲存為 Physics2DSettings.asset。 

- Quality：儲存為 QualitySettings.asset。 

- Graphics：儲存為 GraphicsSettings.asset。 

- Network：儲存為 NetworkManager.asset。 

- Editor：儲存為 EditorUserSettings.asset。 



• Build Settings 的內容：  
Build Settings 也在 ProjectSettings 資料夾中儲存為 

EditorBuildSettings.asset。 

• 在 Project 視窗中所變更的資源：  
伴隨專案範圍設置⼀起儲存的還有不具有 Apply 按鈕的資源的變更，例如變

更任何以下的內容： 

- 材質（Material）的參數。 

- Prefab。 

- Animator Controller（狀態機）。 

- Avatar Mask。 

- 任何其它沒有 Apply 按鈕的資源。 



3. ⽴即寫入磁碟的變更（不需要儲存） 
有⼀些類型的變更會⽴即寫入磁碟，⽽不需要執⾏「儲存」的操作。這些包括以
下內容： 

• 變更任何匯入設置會要求使⽤者按 Apply 按鈕： 

⼤多數資源類型的匯入設置會要求按 Apply 按鈕使變更⽣效。這將影響到資
源重新匯入時可以符合新的設置。所以當按下 Apply 按鈕時，這些變更將⽴

即儲存。例如： 

- 變更圖像資源的紋理類型。 

- 改變 3D 模型資源的比例因⼦（Scale Factor）。 

- 變更聲⾳資源的壓縮設置。 

- 任何其它具有 Apply 按鈕的匯入設置。 

• 其它⽴即儲存的變更： 

⼀些其它類型的資料會⽴即或⾃動儲存到磁碟，⽽無需執⾏「儲存」操作： 

- 創建新資源，例如：新材質或 Prefab（但不是後續更改資源）。 

- 烘焙照明資料（烘焙完成時儲存）。 

- 烘焙導航資料（烘烤完成時儲存）。 

- 烘焙遮擋剔除資料（烘烤完成時儲存）。 

- Script 執⾏順序變更（按下 Apply 後，此資料儲存在每個 Script 的 .meta 

檔案中）。 



XXI.執⾏期使⽤ Prefab（⼀） 
到⽬前為⽌，你應該已從根本上了解 Prefab 的概念了。它們是你在遊戲中
可重複使⽤的預先定義 GameObject 與 Component 的集合。 

當你要在執⾏期實例化複雜的 GameObject 時，使⽤ Prefab 會非常⽅便。
實例化 Prefab 的替代⽅法是使⽤程式碼從頭開始創建 GameObject。實例化 
Prefab 與其替代⽅法相比具有許多優點： 

• 你可以⽤⼀⾏程式碼就實例化⼀個 Prefab 並具有完整的功能。⽤程式碼
創建相同的 GameObject 平均需要五⾏程式碼，但可能會更多。 

• 您可以在 Scene 和 Inspector 視窗中快速⽅便地設置、測試和修改 
Prefab。 

• 您可以更改要被實例化的 Prefab，⽽無需更改實例化的程式碼。⼀個簡
易的⽕箭可能會變成超級⽕箭，⽽不需要更改程式碼。 

1. 常⾒情況 
在以下這些例⼦的情況，Prefab 能夠派上⽤場： 

• 透過在不同的位置創建多次來產⽣整體，例如使⽤單⼀個「磚塊」Prefab 建

⽴⼀⾯牆壁。 

• ⽕箭發射器在發射時實例化⾶出的⽕箭 Prefab。Prefab 包含⼀個網格
（Mesh）、Rigidbody、Collider 和⼀個⼦項 GameObject 與它⾃⼰的軌跡拖

尾線（Trail）粒⼦系統。 

• 機器⼈爆炸成許多碎件。完整的、可操作的機器⼈被破壞，使⽤毀壞的機器

⼈ Prefab 替換。這個 Prefab 將由分成許多部分的機器⼈組成，全部都設置了
⾃⼰的 Rigidbody 和粒⼦系統。這種技術使你能夠將機器⼈炸成許多塊，只
需⼀⾏程式碼，使⽤ Prefab 替換掉原物件。 



2. 建⽴牆壁 
在此將說明使⽤ Prefab 與從程式碼建⽴物件的好處。 

⾸先，讓我們從程式碼建⽴磚牆： 

(1) 使⽤ GameObject > Create Empty 建⽴空的 GameObject。 

(2)使⽤上⾯的程式碼儲存為⼀個 Script 檔案，並將此 Script 檔案拖拉到剛剛

建⽴的空的 GameObject。 

如果執⾏該程式碼，將會看到當你進入播放模式時，會看到建⽴了整個磚牆。
CreatePrimitive 和 AddComponent 那兩⾏是與每個單獨的磚相關的功能。現在

還不錯，但是我們的每⼀塊磚都沒有紋理。 要在磚上執⾏的每⼀個額外的動作，
如改變紋理、摩擦⼒或剛體質量，都要額外再寫幾⾏。 

如果你創建了⼀個 Prefab 並且⼿動執⾏所有的設置，則只要使⽤⼀⾏程式碼來
執⾏每個磚塊的創建和設置。當你決定要進⾏更改時，這可以減輕維護和更改⼤
量程式碼。使⽤ Prefab，只需對其進⾏更改即可執⾏。無需更改程式碼。 

如果你為每個磚塊使⽤ Prefab，這是創建牆壁所需的程式碼。 



這不僅非常整潔，⽽且非常能夠重複使⽤。沒有地⽅提到我們正在實例化⼀個⽴
⽅體或者必須包含⼀個剛體。所有的這些都在 Prefab 中定義並且能夠在編輯器

中快速創建。 

現在我們只需要在編輯器中創建 Prefab。就是這樣： 

• 在選單列選擇 GameObject > 3D Object > Cube。 

• 在選單列選擇 Component > Physics > Rigidbody。 

• 在選單列選擇 Assets > Create > Prefab。 

• 在 Project 視窗中，將新的 Prefab 的名稱更改為 Brick。 

• 將 Hierarchy 視窗中創建的 Cube 拖放到 Project 視窗中的 Brick Prefab 上。 

• 使⽤ Prefab 創建，你可以從 Hierarchy 視窗中安然地刪除 Cube（在 

Windows 上 Delete 鍵，Mac 上的 Command+delete）。 

我們已經創建了 Brick Prefab，所以現在必須將它附加到 Scrpit 中的 brick 變數

中。當選擇包含 Script 的空的 GameObject 時，將可在 Inspector 視窗中看⾒ 
Brick 欄位。 

現在將 Brick Prefab 從 Project 視窗拖動到 Inspector 視窗中的 Brick 欄位。按下

播放，將可看到使⽤ Prefab 構建的牆壁。 

這是⼀個可以在 Unity 中重複使⽤的⼯作流程模式。⼀開始你可能會驚異於為什

麼這樣好多了，因為從程式碼創建⽴⽅體的 Script 只有2⾏多。 

由於現在使⽤的是 Prefab，你可以在幾秒鐘內調整 Prefab。想改變所有這些實
例的質量︖只要在 Prefab 中的 Rigidbody 調整⼀次。想為所有實例使⽤不同的

材質︖只要將材質拖到 Prefab 上⼀次。想改變摩擦⼒︖在 Prefab 的 Collider 中
使⽤不同的物理材質⼀次。要將粒⼦系統添加到所有的這些盒⼦上︖只要在 

Prefab 裡添加⼀次⼦項。 



XXII.在執⾏期使⽤ Prefab（⼆） 
1. 實例化⽕箭和爆炸 

這裡是 Prefab 如何適合這種情況： 

(1) 當使⽤者射擊時，⽕箭發射器實例化⼀個⽕箭 Prefab。Prefab 包含網格、

Rigidbody、Collider 以及包含拖尾軌跡粒⼦特效的⼦ GameObject。 

(2)⽕箭撞擊並實例化爆炸 Prefab。爆炸 Prefab 包含⼀個粒⼦系統、隨著時間推
移⽽淡出的光線，以及對周圍 GameObject 造成傷害的 Script。 

雖然可以完全從程式碼中構建⼀個⽕箭 GameObject，但是⼿動添加組件和設置
屬性，實例化 Prefab 是更容易的。你可以⽤⼀⾏程式碼實例化⽕箭，無論⽕箭

的 Prefab 有多複雜。 在實例化 Prefab 之後，還可以修改實例化物件的任何屬性
（例如，可以設置⽕箭剛體的速度）。 

除了更容易使⽤之外，可以稍後更新 Prefab。所以如果你正在建⼀個⽕箭，你不

需要⽴即添加⼀個粒⼦軌跡，可以稍後再做。 ⼀旦將 Trail 做為⼦ GameObject 
添加到 Prefab，所有實例化的⽕箭將具有粒⼦軌跡。最後，可以快速調整⽕箭 

Prefab 的屬性，使遊戲更容易微調。 



2. 使⽤破碎物件替代原始物件 
假設你有⼀個完整裝束控制的敵⼈角⾊死亡。可以簡單地在角⾊上播放死亡動畫，
並停⽤處理敵⼈邏輯的所有腳本。可能需要刪除多個腳本，添加⼀些⾃定義邏輯，

以確保沒有⼈會繼續攻擊死掉的敵⼈，以及做其他的清理任務。 

另⼀個更好的⽅法是⽴即刪除整個角⾊，並將其替換為被破壞的 Prefab 的實例。
這就給了你很⼤的靈活性。你可以為死亡角⾊使⽤不同的材質，附加完全不同的

腳本，產⽣⼀個 Prefab 檔案，包含破碎成許多部位的物件，以模擬⼀個粉碎的
敵⼈。 

這些都可以通過⼀次呼叫 Instantiate() 來實現，只需將其連接到正確的 
Prefab，即可設置！ 

要記住的重要部分是，Instantiate() 的殘骸可以由與原始物體完全不同的物件製

成。例如，如果你有⼀架⾶機，你可以建⽴兩個版本。⼀個⾶機由⼀個具有網格
渲染器的 GameObject 和⾶機物理腳本組成。將模型保持在⼀個 GameObject 

中，遊戲將運⾏得更快，因為可以使⽤較少的三角形來形成模型，並且由於它比
使⽤許多⼩部件的渲染速度更快，所以渲染的物件數量將會減少。⽽且，當你的
⾶機⾼興地⾶來⾶去時，沒有理由將它分開。 

要建造⼀架失事的⾶機 Prefab，典型的步驟是： 

(1) 使⽤你熟悉的建模軟體建造⾶機的許多部位。 

(2)創建⼀個空的場景。 

(3)將模型拖動到空的場景中。 

(4)選擇所有部件並選擇 Component-> Physics-> Rigidbody，將剛體添加到所

有部件。 

(5)選擇所有部件並選擇 Component-> Physics-> Box Collider 將 Box Colliders 

添加到所有部件。 

(6)要獲得額外的特殊效果，可以將每個零件添加⼀個煙霧粒⼦系統作為⼦ 
GameObject。 

(7)現在你有⼀架有多個爆炸部件的⾶機，它們通過物理掉落到地⾯，並由於附
著的粒⼦系統⽽造成⼀個粒⼦軌跡。點擊播放以預覽模型如何反應並進⾏任

何必要的調整。 



(8)選擇 Assets->Create Prefab。 

(9)將包含所有⾶機零件的 GameObject 拖到 Prefab 中。 

以下⽰範顯⽰了這些步驟使⽤的程式碼。 



3. 使⽤特定模式放置⼀堆物件 
如果你想把⼀堆物件放在⼀個網格或圓形圖案中。傳統上，可以通過以下兩種⽅
式完成： 

(1) 從程式碼完全構建⼀個物件。這很麻煩！從腳本輸入值是緩慢、不直覺、沒
價值的麻煩。 

(2)製作完全裝備的物件，複製並放置在場景中。這是很乏味的，將物件精確地

放置在網格中是很困難的。 

所以使⽤ Instantiate() 與 Prefab 取代！你會了解為什麼 Prefab 在這些情況下非

常有⽤。 以下是這些場景所需的程式碼： 

 





XXIII.傳統遊戲輸入控制 
Unity ⽀援鍵盤、操縱桿和遊戲⼿把輸入。 

可以在輸入管理器（Input Manager）中創建虛擬軸（Virtual Axes）和按
鈕，玩家可以在配置視窗中配置鍵盤輸入。 

你可以設置操縱桿、遊戲⼿把、鍵盤和滑鼠，然後通過⼀個簡單的腳本界⾯
訪問它們。通常使⽤軸和按鈕來偽裝遊戲機控制器。或者，你也可以訪問鍵
盤上的按鍵。 



1. Virtual Axes 
• 在程式中，可透過 Virtual Axis（虛擬軸）的名稱來獲得使⽤者的輸入值，這
些名稱可從選單列的 Edit > Project Settings > Input 開啟的 InputManager 獲

得，並且可依據需求⾃⾏新增或修改。 



• 在每個專案被建⽴時，都會伴隨著⼀些預設的 Virtual Axes： 

- Horizonal 和 Vertical 對應到 W、A、S、D 以及⽅向鍵。 

- Fire1、Fire2、Fire3 個別對應到 Control、Alt 和 Windows 按鍵。 

- Mouse X 和 Mouse Y 對應到滑鼠移動的增量。 

• 可使⽤相同的名稱定義多個 Virtual Axis，運⾏時將會回傳其中最⼤的絕對

值，因此，可以為鍵盤、搖桿等輸入設備使⽤多個相同名稱來設置，使得程
式碼裡不⽤考慮到使⽤者的輸入來源。 



• 每個 Axis 可使⽤名稱透過程式碼獲取 -1 到 1 之間的輸入值，中間值為 0。 

• 每個 Axis 可使⽤名稱透過程式碼得知是否該按鍵發⽣作⽤。 

• Axis 設置的按鍵名稱可依據以下規則，這些名稱也可⽤於程式碼中： 

- ⼀般鍵：a、b、c …。 

- 數字鍵：1、2、3 ...。 

- ⽅向鍵：up、down、left、right。 

- ⼩鍵盤：[1]、[2]、[3]、[+]、[equals]。 

- 修飾鍵：right shift、left shift、right ctrl、left ctrl、right alt、left alt、
right cmd、left cmd。 

- 滑鼠按鍵：mouse 0 、mouse 1、mouse 2 …。 

- 搖桿鍵（任何來源）：joystick button 0、joystick button 1、joystick 
button 2 …。 

- 搖桿鍵（指定來源）：joystick 1 button 0、joystick 1 button 1、joystick 2 
button 0、Joystick 2 button 1 …。 

- 特殊鍵：backspace、tab、return、escape、space、enter、insert、
home、end、page up、page down。 

- 功能鍵：f1、f2、f3 … 。 



2. Key Code 
• 在 Virtual Axes 可設置的按鍵，在程式碼中都有對應的 KeyCode 列舉。 

• 使⽤ Input.GetKey、Input.GetKeyUp 和 Input.GetKeyDown，可透過 

KeyCode 或按鍵名稱來獲得指定按鍵的輸入狀態。 



XXIV.⾏動裝置觸控輸入 
在⾏動設備上，Input Class 提供對觸摸螢幕、加速度器等的訪問。 

1. 多點觸碰螢幕 
iPhone 和 iPod Touch 設備能夠追蹤多達五個⼿指同時觸摸屏幕。你可以通過訪
問 Input.touches 屬性陣列來檢索在最後⼀幀期間觸摸螢幕的每個⼿指的狀態。 

Android 設備對追踪的⼿指數量沒有統⼀的限制。反⽽，因設備之間的不同，會
是在較舊設備上的兩點觸摸到⼀些較新設備上的五個⼿指。 

每個⼿指觸碰經由 Input.Touch 資料結構表⽰： 

• finger：觸碰的唯⼀索引。 

• position：觸碰的螢幕位置。 

• deltaPosition：⾃上⼀幀起，所改變的螢幕位置。 

• deltaTime：⾃上⼀次狀態改變以來，所經過的時間。 

• tapCount：iPhone / iPad 螢幕能夠區分使⽤者的快速⼿指敲擊。該計數器讓

你知道使⽤者在不移動⼿指兩側的情況下輕拍螢幕的次數。Android 設備不計
算敲擊數，此欄位始終為 1。 

• phase：描述所謂的「階段」或觸碰的狀態。它可以幫助你確定觸碰是剛剛開
始、使⽤者是否移動⼿指或者只是抬起⼿指。 

phase 有以下狀態： 

- Began：⼿指剛觸碰螢幕。 

- Moved：⼿指在螢幕移動。 

- Stationary：⼿指觸摸螢幕，但⾃從上⼀幀起就沒有移動。 

- Ended：⼿指從螢幕上抬起。這是觸碰的最後階段。 

- Canceled：系統取消追蹤觸碰，例如⽤⼾將設備放置在臉部或同時發⽣超

過五次觸碰時。這是觸碰的最後階段。 

以下是個⽰範腳本，當使⽤者點擊螢幕時，它將射出⼀個射線： 



 

2. 滑鼠模擬 
在原⽣觸碰⽀援上，Unity iOS / Android 提供鼠標模擬。你可以使⽤標準 Input 
Class 的滑鼠功能。不過請注意，iOS / Android 設備旨在⽀援多種⼿指觸摸。使
⽤滑鼠功能只⽀援單⼀⼿指觸碰。⽽且，⾏動設備上的⼿指觸碰可以從⼀個區域

移動到另⼀個區域，⽽不是在它們之間游動。⾏動設備上的滑鼠模擬將提供移動，
因此與觸碰輸入相比是非常不同的。建議是在早期開發過程中使⽤滑鼠模擬，在

之後盡可能使⽤觸碰輸入。 



3. 加速度傳感器 
隨著⾏動設備的移動，內建的加速度器會在三維空間中彙報沿三個主軸的線性加
速度變化。每個軸的加速度直接由硬體直接彙報為 G ⼒值。1.0 的值表⽰沿著特

定軸約 +1g 的負荷，⽽ -1.0 的值表⽰ -1g。如果你保持設備直⽴（Home 鍵在底
部），X軸的正值在右邊，Y軸的正值在上⾯，Z軸正值指向你。 

以下是使⽤加速度器移動物件的⽰範腳本： 



4. 低通濾波器 
加速度器的讀數可能會變得很嘈雜。對信號進⾏低通濾波可以使其平滑並擺脫⾼
頻噪聲。 

以下腳本顯⽰如何將低通濾波應⽤於加速度器讀數： 

lowPassKernelWidthInSeconds 的值越⼤，濾波值越接近於當前輸入樣本（反之
亦然）。 



XXV.轉換組件 Transform（⼀） 
Transform ⽤於儲存 GameObject 的位置、旋轉、縮放和⽗⼦狀態，因此非
常重要。GameObject 將始終具有附加的 Transform 組件 - 無法刪除 
Transform 或創建沒有 Transform 的 GameObject。 

1. 編輯 Transform 
Transform 在 3D 空間中使⽤ X、Y 和 Z 軸操作，或在 2D 空間中僅使⽤ X 和 Y 
軸進⾏操作。在 Unity 中，這些軸分別由紅⾊、綠⾊和藍⾊表⽰。 

Transform 可以在 Scene 視窗中編輯，或在 Inspector 視窗中更改其屬性。在場
景中，可以使⽤移動、旋轉和縮放⼯具修改 Transform。這些⼯具位於 Unity 編

輯器的左上角。 

這些⼯具可以使⽤在場景中的任何物件。當你點擊物件時，將看到⼯具出現在物
件上。⼯具的外觀取決於選擇了哪個⼯具。 



當你點擊並拖動三個⼯具軸之⼀時，會注意到其顏⾊變為⿈⾊。當拖動滑鼠時，
將看到物件沿所選軸的平移、旋轉或縮放。放開滑鼠按鈕時，軸保持選中狀態。 

在 Translate 模式中還有⼀個附加選項可將移動鎖定到特定的平⾯上（即允許拖
動兩個軸，同時保持第三個不變）。Translate ⼯具中⼼附近的三個⼩彩⾊⽅塊

啟動每個平⾯鎖︔顏⾊對應於當點擊⽅形時將被鎖定的軸（例如，藍⾊鎖定Z
軸）。 



2. ⽗⼦化 
⽗⼦化是使⽤ Unity 時所要了解的最重要的概念之⼀。當 GameObject 是另⼀個 
GameObject 的⽗級時，⼦ GameObject 會隨其⽗級⼀樣移動、旋轉和縮放。你

可以將⽗⼦化視為像你的⼿臂和身體之間的關係︔每當你的身體移動，你的⼿臂
也隨之移動。⼦物件也可以擁有⾃⼰的⼦物件等等。所以你的雙⼿可以被視為⼿
臂的「孩⼦」，然後每隻⼿都有幾根⼿指等等。任何物件都可以有多個⼦物件，

但只有⼀個⽗級。這些多級別的⽗⼦關係形成⼀個 Transform 層次結構。層次
結構頂端的物件（即層次結構中唯⼀沒有⽗項的物件）稱為根（Root）。 

可以透過將 Hierarchy 視窗中的任何 GameObject 拖動到另⼀個來創建⼀個⽗
級。這將在兩個 GameObject 之間創建⼀個⽗⼦關係。 

請注意，對於任何⼦ GameObject 的 Inspector 視窗中的 Transform 值將顯⽰相
對於⽗物件的 Transform 值。這些值被稱為局部坐標。回到身體和⼿臂的類

比，你的身體的位置可能會隨著你的⾏⾛⽽移動，但你的⼿臂仍然會在相同的位
置被附著。對於場景構造，通常使⽤本地坐標來進⾏⼦物件，但是在遊戲中，通
常可以在世界空間或全域坐標中找到它們的確切位置。Transform 組件的腳本 

API 具有單獨的屬性，⽤於區域和全域位置、旋轉和縮放，還允許轉換區域和全
域坐標之間的任意點。 



XXVI.轉換組件 Transform（⼆） 
1. 非均勻縮放的局限性 

不均勻縮放是當 Transform 中的縮放對於 X、Y 和 Z 具有不同的值時，例如
（2,4,2）。相反，均勻縮放對於 X、Y 和 Z 具有相同的值，例如（3,3,3）。在

⼀些特定情況下，非均勻縮放可能是有⽤的，但是它有⼀些在均勻縮放不會出現
的怪異現象： 

• 某些組件不完全⽀援非均勻縮放。例如，⼀些組件具有由半徑屬性定義的圓

形或球形元素，其中包括 Sphere Collider、Capsule Collider、Light 和 
Audio Source。在這種情況下，圓形的形狀將不會像所期望的那樣在非均勻

縮放下變為橢圓形，並且將保持圓形。 

• 當⼦物件具有不均勻縮放的⽗項並相對於該⽗物件旋轉時，它可能會出現傾
斜或「剪切」。有些組件⽀援簡單的非均勻縮放，但是在這樣的傾斜時不能

正常⼯作。例如，傾斜的 Box Collider 將不會准確地匹配渲染網格的形狀。 

• 出於效能原因，非均勻縮放⽗項的⼦物件在旋轉時不會⾃動更新其縮放比例。

結果，當縮放比例最終被更新時，⼦物件的形狀可能會突然改變，比如說⼦
物件可能與⽗物件分離。 

2. 比例的重要性 
Transform 的比例決定了建模應⽤軟體中網格的⼤⼩與 Unity 中該網格的⼤⼩之

間的差異。Unity 中的網格⼤⼩（因此是 Transform 的 Scale）非常重要，特別
是在物理模擬過程中。預設情況下，物理引擎假設世界空間中的⼀個單位對應於

⼀⽶。如果物體非常⼤，可能會出現「慢動作」降落︔模擬實際上是正確又有效
的，因為你正在看著很遠的⼀個非常⼤的物體下降。 

有三個因素會影響物件的比例： 

• 你的3D 建模應⽤程式中的網格尺⼨。 

• 物件匯入設置中的網格比例因⼦設置。 

• Transform 組件的縮放值。 



理想情況下，你不應該調整 Transform 組件中物件的縮放。最好的選擇是依據
現實⽣活中的比例創建你的模型，所以你不必改變 Transform 的比例。下⼀個

最佳選擇是在單⼀個網格的匯入設置中調整匯入網格的比例。基於匯入⼤⼩發⽣
某些最佳化，實例化具有調整縮放比例的物件會降低性能。 

3. 使⽤ Transform 的幾個提⽰ 
• Transform ⽗⼦化時，在添加⼦物件之前將⽗節點的位置設置為（0,0,0）是

非常有⽤的。這意味著⼦物件的區域坐標將與全局坐標相同，從⽽更容易確
保你的⼦物件處於正確的位置。 

• 你可以從 Preferences（選單：Unity > Preferences，然後選擇 Colors & keys 
⾯板）更改 Transform 軸（和其他 UI 元素）的顏⾊。 

• 改變比例會影響⼦物件 Transform 的位置。例如，將⽗物件縮放為（0,0,0）

將會相對於⽗物件將所有⼦物件置於（0,0,0）。 



XXVII.添加隨機性遊戲元素（⼀） 
隨機選擇的項⽬或值在許多遊戲中都很重要。接下來要介紹如何使⽤ Unity 
的內建隨機函數來實現⼀些常⾒的遊戲機制。 

1. 從陣列中選擇隨機項⽬ 
隨機抽取陣列元素可以選擇零和陣列最⼤索引值之間的隨機整數（等於陣列的長
度減去 1）。這可以使⽤內建的 Random.Range 函數輕鬆完成： 

請注意，Random.Range 是從包含第⼀個參數的範圍返回值，但不包括第⼆個參
數值的範圍，因此在此處使⽤ intArray.Length 提供正確的結果。 



2. 選擇不同機率的項⽬ 
有時候，需要隨意選擇項⽬，但有些項⽬比其他項⽬更有可能被選擇。例如，
NPC 在遇到玩家時可能會以幾種不同的⽅式作出反應： 

• 50％ 的機會友善問候。 

• 25％ 的機會逃跑。 

• 20％ 的機會⽴即攻擊。 

• 5％ 的機會提供錢做為禮物。 

你可以將這些不同的結果視覺化為紙條，分為各⾃佔據條帶總長度的⼀部分。所
佔據的比例等於選擇結果的機率。做出選擇等同於沿著條帶的長度（就像投擲⾶

鏢）選擇⼀個隨機點，然後查看它在哪⼀個部分。 

 

在腳本中，紙條實際上是⼀系列浮點數，其中包含項⽬的不同機率。隨機點是通

過將 Random.value 乘以陣列中所有浮點數的總和獲得的（它們不需要加起來為 
1;重要的是不同值的相對⼤⼩）。要查找的點為「in」陣列元素，⾸先檢查它是

否⼩於第⼀個元素中的值。如果是這樣，那麼第⼀個元素是所選的元素。否則，
從點值中減去第⼀個元素的值，並將其與第⼆個元素進⾏比較，依此類推，直到
找到正確的元素。在程式碼中，這看起來像下⾯這樣： 



請注意，最終返回語句是必需的，因為 Random.value 可以返回 1 的結果。在這
種情況下，搜索將不會在任何地⽅找到隨機點。 



3. 加權連續隨機值 
如果你要有不連續的結果，那麼浮點數陣列的⽅法會運⾏地很好，但是你也可能
會想要產⽣更連續的結果 - 比如說，要隨機分配寶箱中發現的⾦幣數量，並且希

望可能會在 1 到 100 之間的任何數字中得到最終結果。使⽤浮點數陣列的⽅法來
執⾏將需要設置⼀個上百個浮動數的陣列（即紙條上的部分），這是很笨重的︔
如果您不限於整數，⽽是希望在範圍內使⽤任何數字，則不可能使⽤該⽅法。 

⼀個更好的連續結果的⽅法是使⽤ AnimationCurve 將「原始」隨機值轉換為
「加權」值︔通過繪製不同的曲線形狀，可以產⽣不同的權重。程式碼也更簡單：

 

通過從 Random.value 取得 0 到 1 之間的「原始」隨機值。然後將其傳遞給 

curve.Evaluate()，將其視為⽔平坐標，並返回該⽔平位置處的曲線的相應垂直
坐標。 



曲線的平坦部分具有更⼤的機會被選擇到，⽽較陡部分被選到的機會較低。 

 

 



請注意，這些曲線不是機率分佈曲線，⽽更像是反向累積機率曲線。 

透過在腳本上定義⼀個公開 AnimationCurve 變數，將可以通過 Inspector 視窗
查看和編輯曲線，⽽不需要計算值。 

這種產⽣浮點數的技術。如果要計算整數結果 - 例如，需要 82 個⾦幣，⽽不是 
82.1214 個⾦幣，可以將計算的值傳遞給像 Mathf.RoundToInt() 這樣的函數。 



4. 洗牌 
⼀種常⾒的遊戲機制是從⼀組已知的項⽬中進⾏選擇，但是按照隨機順序進⾏。
例如，⼀副撲克牌通常會被洗牌，因此它們不能以可預測的順序抽出。你可以通

過訪問每個元素並將其與陣列中的隨機索引中的另⼀個元素進⾏交換來隨機排列
陣列中的項⽬： 



XXVIII.添加隨機性遊戲元素（⼆） 
1. 選出不重複的項⽬ 

⼀種常⾒的任務是從⼀個集合中隨機選擇⼀些項⽬，⽽不是多次挑選相同的項⽬。
例如，你可能希望在隨機⽣成點⽣成⼀些 NPC，但要確保在每個點只⽣成⼀個 

NPC。這可以通過重複排序項⽬來完成，為每個項⽬隨機決定是否將其添加到所
選擇的集合中。隨著每個項⽬被造訪，其被選擇的機率仍然等於需要的數量除以
可供選擇的數量。 

例如，假設有⼗個產⽣點可⽤，但只能選擇五個。選擇第⼀個項⽬的概率為 5/
10 或 0.5。如果選擇⼀個，那麼第⼆個項⽬的概率將是 4/9 或 0.44（即仍然需

要四個項⽬，九個可供選擇）。然⽽，如果沒有選擇第⼀個，那麼第⼆個的概率
將為 5/9 或 0.56（即，仍然需要五個，剩下九個可供選擇）。這⼀直持續到集
合包含所需的五個項⽬。可以通過以下程式碼完成此操作： 



請注意，雖然選擇是隨機的，但所選集中的項⽬將與原始陣列中的順序相同。如
果要按順序⼀次使⽤這些項⽬，則排序可以使其部分可預測，因此可能需要在使

⽤前洗牌。 

2. 空間裡的隨機點 
可以通過將 Vector3 的每個組件設置為 Random.value 返回的值來選擇⽴⽅體體
積中的隨機點： 

這給予⼀個⽴⽅體內⼀個單位長的⼀個點。可以通過將向量的 X、Y 和 Z 分量乘
以所需的邊長度來簡單地縮放⽴⽅體。如果其中⼀個軸設置為零，則該點將始終

位於單個平⾯內。 例如，選擇地⾯上的隨機點通常是隨機設置 X 和 Z 分量，並
將 Y 分量設置為零。 

當體積是⼀個球體（即，當你想要從原點起⼀個給定半徑內的隨機點）時，可以

使⽤ Random.insideUnitSphere 乘以所需的半徑： 



請注意，如果將其中⼀個向量組件的結果設置為零，則不會在圓內獲得正確的隨
機點。雖然這⼀點確實是隨機的，並且位於正確的半徑範圍之內，但是這個概率

對於圓的邊緣有很⼤的偏向，所以所獲得的點將非常不均勻地擴散。應該要為此
⽬的使⽤ Random.insideUnitCircle：  



XXIX.Unity 的旋轉與⽅向（⼀） 
3D 應⽤程式中的旋轉通常⽤兩種⽅式之⼀表⽰，即四元數或歐拉角。每個
都有⾃⼰的⽤途和缺點。Unity 在內部使⽤四元數 ，但是在 Inspector 視窗
中顯⽰等效的歐拉角度的值，以便讓你編輯。 

1. 歐拉角 Euler Angle 
歐拉角具有更簡單的表⽰，它們是順序施加的三個角度值 X，Y 和 Z。為了將歐
拉旋轉應⽤於特定物體，每個旋轉值依次被施加為圍繞其對應軸線的旋轉。 

• 優點：歐拉角具有直覺的「可讀」格式，由三個角度組成。 

• 優點：歐拉角可以表⽰從⼀個⽅向到另⼀個⽅向的轉動超過 180 度。 

• 限制：歐拉角受到萬向鎖（Gimbal Lock）的影響。依次施加三次旋轉時，第

⼀或第⼆旋轉可能導致第三軸指向與先前軸之⼀相同的⽅向。這意味著「⾃
由度數」已經喪失，因為第三個旋轉值不能應⽤於唯⼀的軸。 

2. 四元數 Quaternion 
四元數可以使⽤來表⽰物件的⽅向或旋轉。此表⽰內部由四個數字組成（在 
Unity 中參考為 X、Y、Z 和 W），但是這些數字並不代表角度或軸，通常不需
要直接訪問它們。除非你特別有興趣於研究四元數學，否則你只需要知道四元數

代表 3D 空間中的旋轉，你通常不需要知道或修改 X，Y 和 Z 屬性。 

以向量可以表⽰位置或⽅向（其⽅向從原點測量）相同的⽅式，四元數可以表⽰

⽅向或旋轉 - 其中旋轉是從旋轉「原點（Origin）」或「標識（Identity：這個
四元數對應於“不旋轉” - 物件與世界或⽗軸完全對齊。）」測定的。因為旋轉以
這種⽅式測量 - 從⼀個⽅向到另⼀個⽅向 - 四元數不能表⽰超過 180 度的旋轉。 

• 優點：四元數旋轉並不受到萬向鎖的影響。 

• 限制：單⼀個四元數不能表⽰任何⽅向超過180度的旋轉。 

• 限制：四元數的數字表⽰⽅式是不能直覺的理解的。 

在 Unity 中，所有的遊戲物件旋轉都是內部儲存為四元數，因為它的優點超過限
制。 



然⽽，在 Inspector 視窗中的 Transform，使⽤歐拉角顯⽰旋轉，因為這更容易
理解和編輯。輸入到 Inspector 中的遊戲物件旋轉的新值將被轉換為「防護」下

的物件的新的四元數旋轉值。 

做為副作⽤，Inspector 視窗可以為遊戲物件的旋轉旋轉輸入 X：0、Y：365、
Z：0 的值。這是⼀個不可能表⽰為四元數的值，所以當你點擊 Play 時，會看到
物件的旋轉值更改為 X：0、Y：5、Z：0（或其周圍）。這是因為旋轉被轉換為

不具有「完整 360 度旋轉加 5 度」概念的四元數，⽽是簡單地將其設置為與旋
轉結果相同的⽅向。 

3. 對編寫腳本的影響 
使⽤你的腳本應對處理旋轉時，應該使⽤ Quaternion Class 及其函數來創建和修

改旋轉值。在某些情況下，使⽤歐拉角是有效的，但你應該牢記：你應該使⽤處
理歐拉角的 Quaternion Class 函數 - 從旋轉中檢索、修改和重新套⽤歐拉值可能

導致偶然的副作⽤。 

然⽽有時候，腳本中可能需要使⽤歐拉角。在這種情況下，重要的是要注意，必
須將角度保持在變數中，並且只能使⽤它們將它們應⽤於您的旋轉的歐拉角。雖

然可以從四元數中檢索歐拉角，但如果檢索，修改和重新套⽤，則會出現問題。 

以下是使⽤假設的範例，嘗試以每秒 10 度旋轉物件的錯誤例⼦。 這是你應該避

免的： 



這裡的錯誤是我們正在持續修改四元數的 X 值，該值不表⽰角度，並不會產⽣
期望的結果。 

這裡的錯誤是我們正在讀取、修改然後從四元數寫入歐拉值。因為這些值是從四
元數計算出來的，所以每個新的旋轉可能會返回非常不同的歐拉角，這可能會遭

受萬向鎖定。 

這裡是正確使⽤歐拉角度的例⼦： 

在這裡，我們將歐拉角儲存在⼀個變數中，只⽤它來應⽤為歐拉角，但是從不依
賴於讀取歐拉。 



XXX.Unity 的旋轉與⽅向（⼆） 
Unity 的 Quaternion Class 具有許多功能，允許你創建和操作旋轉，⽽無需
使⽤歐拉角。 

1. 使⽤ Quaternion 建⽴旋轉 
• Quaternion.LookRotation：使⽤指定的向前和向上⽅向創建旋轉。回傳計算
出的四元數。 

• Quaternion.AngleAxis：創建圍繞軸旋轉角度的旋轉。 



• Quaternion.FromToRotation：從⼀個⽅向朝另⼀個⽅向建⽴旋轉。 

2. 使⽤ Quaternion 操作旋轉 
• Quaternion.Slerp：透過⼀個 t 值在兩個旋轉四元數之間球體插值，t 值介於 

0~1 的範圍之間。 



• Quaternion.Inverse：回傳旋轉的反向。 

• Quaternion.RotateTowards：從來源向⽬標旋轉⼀個角度。透過最⼤度數變
化（maxDegreesDelta）將來源的四元數轉向⽬標（但旋轉不會超過⽬

標），最⼤度數變化為負值的話，將會旋轉到完全相反的⽅向。 



3. 對動畫的影響 
許多 3D 創作包，以及 Unity ⾃⼰的內部 Animation 視窗，允許在動畫過程中使
⽤歐拉角來指定旋轉。 

這些旋轉值往往可以超過四元數能夠表達的範圍。例如，如果物件應該在原位旋
轉720度，則可以⽤歐拉角 X：0、Y：720、Z：0 表⽰。但這根本不是四元數所
能表達代表的值。 

• Unity 的 Animation 視窗 

在 Unity ⾃⼰的 Animation 視窗中，有⼀些選項允許指定如何插值旋轉 - 使

⽤四元數或歐拉插值。通過指定歐拉插值，表⽰告訴 Unity，你希望透過角度
指定的全部運動範圍。然⽽，使⽤四元數旋轉，只是想要旋轉到特定⽅向結
束，Unity將使⽤四元數插值，並在最短距離內旋轉到達。 

• 外部動畫來源 

從外部來源匯入動畫時，這些檔案通常包含歐拉格式的旋轉關鍵幀動畫。

Unity 預設⾏為是重新採樣這些動畫，並為動畫中的每個幀⽣成⼀個新的四元
數關鍵幀，以避免關鍵幀之間的旋轉可能超過四元數有效範圍的任何情況。 

例如，假設兩個關鍵幀相隔 6 幀，第⼀個關鍵幀上的 X 為 0，第⼆個關鍵幀

為 270。在沒有重新採樣的情況下，這兩個關鍵幀之間的四元數插值將沿相反
⽅向旋轉 90 度，因為這是從第⼀⽅向到第⼆⽅向的最短⽅式。然⽽，通過在

每個幀上重新採樣和添加關鍵幀，關鍵幀之間現在只有 45 度，所以旋轉將正
常⼯作。 

仍然有⼀些情況 - 即使重新採樣 - 匯入的動畫四元數表⽰可能與原始的不完全

相符，因此，在Unity 5.3 及以上版本中，可以選擇關閉動畫重新採樣，以便
可以在運⾏時使⽤原始的歐拉動畫關鍵幀。 



XXXI.遊戲中的照明 
照明是每個場景的必要組成部分。網格和紋理定義場景的形狀和外觀，照明
定義 3D 環境的顏⾊和氣氛。可能會在每個場景中使⽤多個光源。使它們共
同運作需要⼀點練習，但結果會是相當驚⼈的。 

可以從 GameObject > Light 選單將光源添加到場景中。從出現的⼦選單中
選擇所需的光源格式。⼀旦添加了光，你可以像任何其它 GameObject ⼀樣
操縱它們。此外，可以通過使⽤ Component > Rendering > Light 向所選的 
GameObject 添加 Light Component。 

Inspector 視窗中，Light Component 中有許多不同的選項。 



通過簡單的改變光的顏⾊，能夠獲得完全不同氣氛的場景。 

陽光明媚的照明 

⿊暗、中世紀的照明 



陰森的夜間照明 

1. 渲染路徑 
Unity ⽀持各種渲染路徑。這些路徑主要影響燈光和陰影，因此根據遊戲需求選

擇正確的渲染路徑可以提⾼專案的效能。 

你應該根據你的遊戲內容和⽬標平台/硬體選擇使⽤哪⼀個。不同的渲染路徑具
有不同的效能特徵，主要影響光和陰影。 

你的專案使⽤的渲染路徑可在 Graphics Settings 中選擇。此外，可以針對每個
攝影機覆蓋這個設置。 

如果顯⽰卡無法處理所選的渲染路徑，Unity 將⾃動使⽤較低保真度的。例如，
在不能處理延遲著⾊（Deferred Shading）的 GPU 上，將使⽤前向渲染
（Forward Rendering）。 

• 延遲著⾊ Deferred Shading：延遲著⾊是具有最多照明和陰影保真度的渲染
路徑，如果有許多即時照明，則最適合。它需要⼀定程度的硬體⽀援。 

• 前向渲染 Forward Rendering：這是傳統的渲染路徑。它⽀持所有典型的 
Unity 圖形功能（法線貼圖、每像素照明、陰影等）。然⽽，在預設設置下，
只有少數最亮的燈在每像素照明模式下渲染。剩下的燈是在物件頂點或每個

物件上計算的。 



• 傳統延遲 Legacy Deferred：傳統延遲與延遲著⾊類似，只是使⽤不同的技
術，不同的權衡。它不⽀持基於 Unity 5 的標準著⾊器。 

• 傳統頂點光 Legacy Vertex Lit：Legacy Vertex Lit 是具有最低照明保真度的
渲染路徑，不⽀援即時陰影。它是前向渲染路徑的⼀個⼦集。 

注意：使⽤正交（Orthographic）投影時不⽀持延遲渲染。如果攝影機的投影模

式設置為「正交（Orthographic）」，則這些值將被覆蓋，攝影機將始終使⽤前
向渲染。 



XXXII.跨平台遊戲構建與發佈要項 
在創建遊戲的任何時候，你可能希望看到以單機⽅式構建並在編輯器之外運
⾏時的外觀。 

選單 File > Build Settings... 開啟 Build Settings 視窗。會彈出⼀個可編輯的
場景列表，當構建遊戲時將包含這些場景。 

第⼀次在專案中查看此視窗時，它顯⽰為空⽩。如果在此列表空⽩時構建遊
戲，則只有當前打開的場景才會包含在構建中。如果要快速構建⼀個只有⼀
個場景檔案的測試播放器，只需構建⼀個空⽩場景列表的播放器。 

要構建多個場景，只要簡單的添加場景檔案到列表。有兩種⽅法可以添加它
們。第⼀種⽅法是點擊 Add Open Scenes 按鈕。將看到當前打開的場景出
現在列表中。添加場景檔案的第⼆種⽅法是將它們從 Project 視窗拖動到列
表中。 



此時，請注意，每個場景都有不同的索引值。場景０是要載入的第⼀個場景。
當要載入新場景時，請在腳本中使⽤ SceneManager.LoadScene()。 

如果添加了多個場景檔案並想重新排列，只需點擊並拖動列表上⽅或下⽅的
場景，直到按照所需順序排列。 

如果要從列表中刪除場景，請點擊選取場景，然後按 Delete。場景將從列表
中消失，不會包含在構建中。 

當您準備發佈構建時，選擇⼀個平台，並確保 Unity 標誌位於該平台旁邊︔
如果不是，點擊 Switch Platform 按鈕，讓 Unity 知道要構建哪個平台。最
後按 Build 按鈕。可以使⽤標準的「儲存」視窗來決定遊戲的名稱和位置。
點擊儲存時，Unity 會建⽴你的遊戲內容。這很簡單 如果不確定要在哪裡儲
存你構建的遊戲，請考慮將其儲存到專案的根⽬錄中。不要將構建儲存到 
Assets ⽂件夾中。 

勾選 Development Build 將啟⽤ Profiler 功能，並且會使 Autoconnect 
Profiler 和 Script Debugging 選項可⽤。 

1. 建⽴單機播放器 
使⽤ Unity 可以為 Windows、Mac 和 Linux 構建獨⽴的應⽤程式。這只要在 
Build Settings 中選擇構建⽬標，並點擊 Build 按鈕。構建單機播放器時，⽣成

的檔案將根據構建⽬標⽽有所不同。對於 Windows，將構建可執⾏檔案
（.exe），並包含應⽤程式所有資源的 Data 資料夾。對於 Mac，將構建⼀個包
含運⾏應⽤程式所需的檔案以及資源的應⽤程式包。 

在 Mac 上發佈，只是提供應⽤程式包（所有東西都包裝在裡⾯）。在 Windows 
上，你需要提供 .exe 檔案和 Data 資料夾給其他⼈運⾏。其他⼈必須在他們的電

腦上具有相同的檔案，以你為 Unity ⽣成的檔案來運⾏你的遊戲。 

2. 構建過程 
構建過程將會在你指定的地⽅放置構建的遊戲應⽤程式的空⽩副本。然後，它將
透過 Build Settings 中的場景列表⼯作，⼀次在編輯器中打開、最佳化它們，並



將它們整合到應⽤程式包中。還將會計算所包含場景所需的所有資源，並將該資
料儲存在應⽤程式包中的個別檔案中。 

• 已發佈的構建中，不包含場景中標有「EditorOnly」的任何 GameObject。這
對於最終不需要包含在遊戲中的除錯腳本很有⽤。 

• 當新的關卡載入時，上⼀個關卡的所有物件都將被銷毀。為了防⽌這種情況，

請對任何不想銷毀的物件使⽤ DontDestroyOnLoad()。這最常⽤於在載入關
卡時保持⾳樂播放或者⽤於保持遊戲狀態和進度的遊戲控制器腳本。 

• 載入新的關卡完成後，OnLevelWasLoaded() 將被發送到所有現⾏的遊戲物
件。 

3. 預載 
已發佈的構建會在場景載入時⾃動預載場景中的所有資源。場景 0 是這規則的例

外，這是因為第⼀個場景通常是⼀個啟動畫⾯，你會希望盡可能快地顯⽰。 

為了確保所有內容都已預載，可以創建⼀個呼叫 SceneManager.LoadScene(1）

的空場景。在構建設置中，使這個空場景的索引為 0，隨後的所有關卡都將被預
載。 



XXXIII.Unity 程式設計介紹 
腳本是所有遊戲的重要組成部分。即使是最簡單的遊戲也需要腳本來回應來
⾃玩家的輸入並安排遊戲中應該發⽣的事件。除此之外，腳本可⽤於創建圖
像效果、控制物件的物理⾏為，甚至可以為遊戲中的角⾊實現⾃定義 AI 系
統。 

腳本是⼀種需要⼀些時間和精⼒去學習的技能。這裡不是教你如何從頭開始
編寫腳本程式碼，⽽是解釋適⽤於 Unity 中腳本的主要概念。 

雖然 Unity 使⽤標準 Mono 執⾏期的腳本來實現，但它仍然有⾃⼰從腳本訪
問引擎的實踐和技術。 

GameObject 的⾏為由附加到它們的組件控制。雖然 Unity 的內建組件可以
有非常多的⽤途，但你很快就會發現，你需要在它可以提供的內容之外實現
⾃⼰的遊戲功能。Unity 讓你能夠使⽤腳本創建⾃⼰的組件。這些，讓你能
夠觸發遊戲事件、隨時間修改組件屬性，並以任何你喜歡的⽅式回應使⽤者
輸入。 

Unity 本身⽀援兩種程式語⾔： 

• C#（發⾳為 C-sharp），類似於 Java 或 C++ 的業界標準語⾔。 

• UnityScript，專為 Unity 使⽤⽽設計並⽤ JavaScript 塑造的語⾔（即將
廢除）。 

除了這些，如果可以編譯相容的DLL，可以使⽤許多其他 .NET 語⾔。 



1. 創建腳本 
與⼤多數其他資源不同，腳本通常直接在 Unity 內創建。你可以從 Project 視窗
左上角的 Create 選單創建新腳本，或者從主選單中選擇 Assets > Create > C# 

Script (或 JavaScript) 。 

將會在 Project 視窗中被選擇的資料夾中創建新腳本。新腳本檔案的名稱將被選
取，並提⽰你輸入新名稱。 

最好是現在輸入新腳本的名稱，⽽不是稍後再編輯。輸入的名稱將⽤於檔案內容
的 Class 名稱。 

2. 腳本檔案剖析 
當您雙擊 Unity 中的腳本資源時，它將在⽂字編輯器中打開。預設情況下，
Unity 將使⽤ MonoDevelop，但你可以從 Unity 的 Preferences 中的 External 
Tools ⾯板中選擇所需的任何編輯器。 

該檔案的的初始內容將如下所⽰： 



⼀個腳本通過實現⼀個繼承⾃ MonoBehaviour 內建 Class 來與 Unity 的內部運
作聯繫起來。你可以將該 Class 視為⼀種創建可以附加到 GameObject 的新組件

類型的藍圖。每次將腳本組件附加到 GameObject 時，它將創建由藍圖定義的物
件新實例。該 Class 的名稱取⾃創建檔案時提供的名稱。Class 名稱和檔名必須
相同才能使腳本組件附加到 GameObject。 

然⽽，主要需要注意的是在 Class 中定義的兩個函數。Update 功能是放置將處
理 GameObject 於每次畫⾯更新的程式碼的地⽅。這可能包括移動、觸發動作和

回應使⽤者輸入，基本上任何需要在遊戲過程中隨時隨地處理的任何事情。通常
在啟⽤ Update 功能來執⾏⼯作、在任何遊戲操作發⽣之前，能夠設置變數、讀
取喜好設定並與其他 GameObject 進⾏連接會很有⽤。在遊戲開始之前（即，在

第⼀次執⾏ Update 功能之前），Unity 將執⾏ Start 函數，⽽且這是進⾏任何初
始化的理想場所。 

有經驗的程式⼈員注意：可能會感到驚訝的是，使⽤建構函數不會對物件進⾏初
始化。這是因為物件的建構由編輯器處理，並且不會像所期望的那樣在遊戲開始
時進⾏。如果嘗試為腳本組件定義建構函數，它將⼲擾 Unity 的正常運⾏，並可

能會引發專案的重⼤問題。 

3. 控制 GameObject 
如上所述，腳本僅定義了組件的藍圖，因此在腳本的實例附加到 GameObject 之

前，它們的程式碼都不會被啟動。你可以通過將腳本資源拖動到 Hierarchy 視窗
中的 GameObject 或當前選擇的 GameObject 的 Inspector 視窗來附加腳本。在 
Component 選單上還有⼀個 Scripts ⼦選單，其中包含專案中可⽤的所有腳本，

包括你⾃⼰創建的腳本。腳本實例看起來與 Inspector 視窗中的任何其他組件類
似： 

⼀旦附加上去，當你按播放來運⾏遊戲，腳本將開始運作。你可以通過在 Start 
功能中添加以下程式碼來檢查： 



Debug.Log 是⼀個簡單的指令，它只向 Unity 的 Console 視窗輸出訊息。如果你
⽴即按播放，應該會在 Unity 編輯器底部和 Console 視窗（選單：Window > 

Console）中看到該訊息。 



XXXIV.Unity 程式構造與編輯
器的關係 
創建腳本時，本質上是創建⾃⼰的新類型的組件，可以像任何其他組件⼀樣
附加到 Game Object。 

就像其他組件⼀樣，通常在 Inspector 視窗中會有可編輯的屬性，可以從 
Inspector 視窗編輯腳本中的值。 

此程式碼在 Inspector 視窗建⽴可編輯的欄位，並將欄位名稱標⽰為「My 
Name」。 

Unity 通過在變數名稱中出現⼤寫字母的位置引入空格來創建 Inspector 欄
位標籤。但是，這純粹僅⽤於顯⽰，你應該始終在程式碼中使⽤原本的變數
名稱。如果編輯該欄位，然後按播放，將看到該訊息包含所輸入的⽂字。 



在 C# 中，須將變數聲明為 public，才能在 Inspector 視窗中出現欄位。 

Unity 將實際上讓你在遊戲運⾏時更改腳本變數的值。這對直接查看更改的
影響非常有⽤，無需停⽌並重新啟動。當遊戲結束時，變數的值將重置為按
下 Play 之前的值。這可以確保你能夠⾃由地調整物件的設置，⽽不⽤擔⼼
造成永久性的傷害。 



XXXV.程式組件對遊戲物件的控制 
在 Unity 編輯器中，可以使⽤ Inspector 視窗更改組件屬性。因此，例如對 
Transform 組件的位置值進⾏更改將導致對 GameObject 的位置變更。相同
地，可以更改 Renderer 材質顏⾊或 Rigidbody 的質量，將對 GameObject 
的外觀或⾏為具有相對應的影響。在⼤多數情況下，腳本也是針對修改組件
屬性來操縱 GameObject。不同之處在於，腳本可以隨時間的變化或回應使
⽤者的輸入來改變屬性的值。通過在正確的時間更改、創建和銷毀物件，可
以實現任何類型的遊戲。 

1. 訪問組件 
最簡單和最常⾒的情況是腳本需要訪問附加到同⼀ GameObject 的其他組件。如
上所述，組件實際上是⼀個 Class 的實例，所以第⼀步是獲取要使⽤的組件實例

的參考。這是通過 GetComponent 函數完成的。通常，你要將組件物件分配給
變數，該變數使⽤以下語法在 C＃ 中完成： 

⼀旦對組件實例進⾏了參考，就可以像 Inspector 視窗那樣設置其屬性的值： 

在 Inspector 視窗中不可⽤的額外功能可以在組件實例上呼叫函數來執⾏： 



還要注意的是，沒有理由不能將多個⾃定義腳本連接到同⼀個物件。如果需要從
⼀個腳本訪問另⼀個腳本，則可以照常使⽤ GetComponent，只需使⽤腳本 

Class 的名稱來指定所需的組件類型。 

如果嘗試取得尚未實際添加到 GameObject 的組件，則 GetComponent 將返回 
null︔如果嘗試更改 null 物件上的任何值，將在運⾏時得到⼀個空參考錯誤。 

2. 訪問其它物件 
雖然它們有時是隔離的操作，但腳本通常保持追蹤其他物件。例如，敵⼈可能需
要知道玩家的位置。Unity 提供了許多不同的⽅式來取得其他物件。 

• 使⽤變數連結物件 

找到相關 GameObject 最簡單的⽅法是將⼀個公開的 GameObject 變數添加到
腳本中： 

該變數將像其他欄位⼀樣在 Inspector 視窗顯⽰： 

 



現在，你可以將場景或 Hierarchy 視窗中的物件拖動到此變數上進⾏配置。就
像任何其他物件⼀樣，可使⽤ GetComponent 函數和訪問組件變數，因此可

以使⽤如下程式碼： 

另外，如果在腳本中聲明組件類型的公開變數，則可以將具有該組件的任何 
GameObject 拖動到其上。這將直接訪問組件，⽽不是 GameObject 本身。 

當處理具有永久連接的各個物件時，將物件與變數鏈接起來最為有⽤。你可以使
⽤陣列變數鏈接相同類型的多個物件，但連接仍然必須在 Unity 編輯器中進⾏，

⽽不是在運⾏時。在運⾏時定位物件通常很⽅便，如下，Unity 提供了兩種基本
的⽅法來實現。 

• 尋找⼦物件 

有時候，遊戲場景會使⽤相同類型的物件，如敵⼈、航點和障礙物。這些可
能需要由管理或對其進⾏反應的特定腳本進⾏跟踪（例如，所有航點可能需

要可⽤於航點腳本）。使⽤變數鏈接這些物件是⼀種可能性，但是如果每個
新的航點都必須被拖動到腳本上的變數，那麼這將使設計過程變得乏味。同
樣地，如果⼀個航點被刪除，那麼必須刪除對該丟失物件的變數參考也是麻

煩的。在這種情況下，通過使它們成為⼀個⽗物件的所有⼦物件來管理整組
物件通常會更好。可以使⽤物件的 Transform 組件（因為所有的 GameObject 

具有 Transform）來取得⼦物件： 



還可以使⽤ Transform.Find 函數透過名稱查找特定的⼦物件： 

當物件具有可以在遊戲過程中添加和刪除的⼦項時，這可以很有⽤。能夠拾
起和放下的武器就是⼀個很好的例⼦。 

• 透過名稱或 Tag 尋找物件 

只要有⼀些訊息來識別，就可以在場景層次結構中的任何位置找到 
GameObject。可以使⽤ GameObject.Find 函數通過名稱找出單⼀個物件： 



物件或物件的集合也可以使⽤ GameObject.FindWithTag 和 
GameObject.FindGameObjectsWithTag 函數通過其 Tag 來找出： 



XXXVI.Unity 事件功能與執⾏順序 
Unity 中的腳本不像程式的傳統想法，程式碼在循環中持續運⾏，直到完成
其任務。相反的，Unity 通過呼叫在其中聲明的某些函數間接地將控制傳遞
給腳本。⼀旦功能完成執⾏，控制就會傳回 Unity。這些功能被稱為事件功
能，因為它們被 Unity 啟動以回應遊戲過程中發⽣的事件。Unity使⽤命名
⽅案來識別要呼叫特定事件的函數。例如，已經看過的 Update 函數（在幀
更新之前呼叫）和 Start 函數（在物件的第⼀幀更新之前呼叫）。Unity 中
還有更多的事件功能可⽤︔完整列表可以在 MonoBehaviour Class 的腳本參
考⾴⾯中找到，以及它們的使⽤細節。以下是⼀些最常⾒和重要的事件。 

1. 定期更新事件 
遊戲就像⼀個動畫，動畫幀是在製作中⽣成的。在遊戲程式中的⼀個關鍵概念是
在渲染每幀之前對遊戲中的物件位置、狀態和⾏為進⾏更改。Update 功能是 

Unity 中此類程式碼的主要地⽅。Update 在渲染幀之前以及在計算動畫之前被
呼叫。 

物理引擎以類似的⽅式在分離的時間階段進⾏更新來進⾏幀渲染。在每次物理更
新之前呼叫⼀個名為 FixedUpdate 的事件函數。由於物理更新和幀更新不會以

相同的頻率發⽣，因此如果將其放置在 FixedUpdate 函數⽽不是 Update 中，則
可以從物理程式碼中獲得更準確的結果。 



有時也可以在對場景中的所有物件呼叫 Update 和 FixedUpdate 函數之後以及在
計算所有動畫之後的某個時間點進⾏其他更改。例如攝影機應該保持對⽬標物件

的瞄準︔必須在⽬標物件移動後對攝影機的⽅向進⾏調整。另⼀個例⼦是腳本程
式碼應該覆蓋動畫的效果（比如說，讓角⾊的頭部朝著場景中的⽬標物件看）。
LateUpdate 功能可⽤於這些情況。 

2. 初始化事件 
能夠在遊戲過程中發⽣的任何更新之前呼叫初始化程式碼通常是有⽤的。Start 
函數在物件的第⼀幀或物理更新之前被呼叫。當場景載入時，對場景中的每個物

件呼叫 Awake 功能。請注意，儘管各種物件以任意順序呼叫 Start 和 Awake 功
能，但所有的 Awake 都將在第⼀個 Start 被呼叫之前完成。這意味著 Start 函數
中的程式碼可以預先在 Awake 階段執⾏其他初始化。 

3. GUI 事件 
Unity 具有⽤於在場景中的主要操作上呈現 GUI 控制以及回應這些控制點擊的系
統。該程式碼的處理⽅式與正常的幀更新有所不同，因此它應該放在 OnGUI 函
數中，將會被定期呼叫。 

還可以檢測出現在 GameObject 中的滑鼠事件。這可以⽤於定位武器或顯⽰當前
在滑鼠指針下的訊息。⼀組 OnMouseXXX 事件函數（例如，OnMouseOver、

OnMouseDown）可⽤於允許腳本使⽤滑鼠對使⽤者操作做出反應。例如，如果
在特定物件上⽅按下滑鼠按鈕，則該物件腳本中的 OnMouseDown 函數將被調
⽤（如果存在）。 



4. 物理事件 
物理引擎將通過呼叫該物件腳本的事件函數來反應物件的碰撞。
OnCollisionEnter、OnCollisionStay 和 OnCollisionExit 函數將被呼叫做為建

⽴、維持和斷開的聯繫。當物件的碰撞器被配置為觸發器（即，只是簡單地檢測
到什麼東西進入⽽不做出反應的碰撞器）時，將呼叫相對應的 
OnTriggerEnter、OnTriggerStay 和 OnTriggerExit 函數。如果在物理更新期間

檢測到多個聯繫，則可以連續呼叫這些功能，因此參數將傳遞給函數提供碰撞的
細節（如進入物件的位置等）。 



XXXVII.時間與幀率管理 
Update 功能讓你能夠監測輸入和定期來⾃腳本的事件，並採取適當的⾏為。
例如，當按下「前進」鍵時，可以移動角⾊。在處理基於時間的操作時，要
記住的⼀件重要的事情是遊戲的幀率以及呼叫 Update 功能之間的時間長度
不是恆定的。 

舉例，思考⼀下將物體逐漸向前移動的任務，⼀次⼀幀。⾸先看起來可能只
是將對象每幀移動⼀個固定的距離： 

然⽽，由於幀時間不是恆定的，所以物體將以不規則的速度移動。如果幀時
間是 10 毫秒，那麼物件將以每秒 100 次的 distancePerFrame 的速度前
進。但是，如果幀時間增加到 25 毫秒（由於 CPU 負載），所以說，它將只
會向前邁進 40 次，因此涵蓋較少的距離。解決⽅案是透過你能夠從 
Time.deltaTime 屬性讀取的幀時間縮放移動的⼤⼩： 

請注意，現在是以 distancePerSecond 移動，⽽不是 distancePerFrame。隨
著幀速率的變化，移動長度將相應地改變，因此物件的速度將會是恆定的。 



1. 固定時間步驟 Fixed Timestep 
與主幀更新不同，Unity 的物理系統確實能夠處理固定的時間步驟，這對於模擬
的準確性和⼀致性很重要。在物理更新開始時，Unity 通過將固定時間步驟的值

添加到最後⼀個物理更新結束的時間來設置「警報」。然後，物理系統將執⾏計
算，直到警報熄滅。 

你可以從 Time Manager 更改固定時間步驟⼤⼩，可使⽤ Time.fixedDeltaTime 

屬性從腳本中讀取它的⼤⼩。請注意，對於時間步驟，較低的值將導致更頻繁的
物理更新和更精確的模擬，但代價是增加 CPU 負載。你可能不需要更改預設的

固定時間步驟，除非你對物理引擎需要很⾼要求。 

2. 最⼤允許時間步驟 Maximum Allowed 
Timestep 
固定的時間步驟保持物理模擬在真實時間上的準確性，但是會在遊戲⼤量使⽤物
理的情況下帶來問題，遊戲幀速率也會變低（由於運⾏的⼤量物件）。主幀更新

進程在頻繁的物理更新之間被「壓縮」，並且如果有很多進程，那麼會在單個幀
期間進⾏多次物理更新。由於幀時間、物件位置和其他屬性在幀的開始處被凍結，

所以圖形可能與更頻繁更新的物理不同步。 

理所當然的，只有這麼多的 CPU 功率可⽤，但 Unity 有⼀個選項，讓你有效地
減慢物理時間，讓幀處理趕上。Maximum Allowed Timestep 設置（在 Time 

Manager 中）限制了 Unity 在給定幀更新期間處理物理和 FixedUpdate 呼叫的
時間量。如果幀更新花費的時間超過 Maximum Allowed Timestep，則物理引擎

將「停⽌時間」，並使幀處理趕上。⼀旦幀更新完成，物理將恢復，因為它已經
停⽌，沒有時間過時。這樣做的結果是，剛體不會像通常那樣即時地完全移動，
但會稍微減慢。然⽽，物理學「時鐘」仍將跟踪它們，就像它們正常地移動⼀樣。

物理時間的減慢通常是不明顯的，是遊戲效能可接受的折中做法。 

3. 時間比例 Time Scale 
對於特殊效果，如「⼦彈時間」，有時可以減慢遊戲時間的流逝，從⽽使動畫和

腳本應對以較低的速度發⽣。此外，你有時可能會完全凍結遊戲時間，就像遊戲
暫停時⼀樣。Unity 具有 Time Scale 屬性，可以控制多快的遊戲時間來相對應真
實時間。如果 Time Scale 設置為 1.0，則遊戲時間與真實時間相同。設為 2.0 會

使得 Unity 的時間速度快兩倍（即，動作將被加速），⽽ 0.5 的值將使遊戲速度



降低到⼀半。零值將使時間完全停⽌。請注意，Time Scale 實際上並不會減慢執
⾏速度，⽽是通過 Time.deltaTime 和 Time.fixedDeltaTime 更改報告給 Update 

和 FixedUpdate 函數的時間步驟。當遊戲時間減慢時，Update 功能可能比平常
更頻繁地呼叫，但是報告每幀的 deltaTime 步驟將減少。其他腳本功能不受 
Time Scale 影響，例如，當遊戲暫停時，可以顯⽰具有正常互動功能的 GUI。 

Time Manager 有⼀個屬性讓你可以全域設置 Time Scale，但從腳本使⽤ 
Time.timeScale 屬性設置該值，通常會更為有⽤。 

4. 奪取幀率 Capture Framerate 
⼀種非常特殊的時間管理情況是你想要將遊戲記錄為影像的地⽅。由於儲存螢幕
圖像的任務需要相當長的時間，因此如果在正常的遊戲過程中嘗試執⾏此操作，

則遊戲幀率會⼤⼤降低。這將導致影像不能反映出遊戲的真實表現。 

所幸，Unity 提供了⼀個 Capture Framerate 屬性，可以讓你解決這個問題。當
該屬性的值設置為零以外的任何值時，遊戲時間將會減慢，幀更新將以精確的定

期間隔發佈。幀之間的間隔等於 1 / Time.captureFramerate，因此如果該值設置



為 5.0，則每五分之⼀秒更新⼀次。隨著對幀速率的要求有效降低，就可以在 
Update 功能中儲存螢幕截圖或執⾏其他操作： 

雖然使⽤這種技術錄製的影像通常看起來非常好，但是當劇烈的放慢時，遊戲很
難玩。可能需要使⽤ Time.captureFramerate 的值試驗，來給予充⾜的錄製時間，
⽽不會使測試播放器的任務過度複雜化。 



XXXVIII.協程 Coroutine（⼀） 
當你呼叫⼀個函數時，它返回之前會運⾏完畢。這實際上意味著在功能中發
⽣的任何動作都必須在單幀更新中進⾏︔函數呼叫不能⽤於包含程序動畫或
隨時間推移的⼀系列事件。例如，逐漸減少物件的 alpha 值（不透明度）直
到完全看不⾒的任務。 

像這樣，淡入淡出功能將不會有你所期望的效果。為了使褪⾊可⾒，必須通
過⼀系列幀來減少 alpha，以顯⽰被渲染的中間值。但是，該功能在單幀更
新中全部執⾏了。中間值將永遠不會被看到，物件將⽴即消失。 

通過將程式碼添加到逐幀執⾏漸變的 Update 功能，可以處理這種情況。然
⽽，對於這種任務使⽤ Coroutine 通常更為⽅便。 

Coroutine 就像⼀個功能，可以暫停執⾏並將控制權返回給 Unity，然後停
留到下⼀個幀再繼續。Coroutine 的聲明如下： 



它實質上是⼀個聲明具備回傳 IEnumerator 類型的函數，並且將 yield 
return 語句包含在函數本體的某個位置。yield return 這⼀⾏是執⾏暫停並
在下⼀幀恢復的位置。要設置 Coroutine 運⾏，需要使⽤ StartCoroutine 函
數： 



你將注意到，淡化功能中的迴圈在 Coroutine ⽣命週期內保持正確的值。實
際上，任何變數或參數都將在 yield 之間被正確保留。 

預設情況下，Coroutine 在它的 yield 之後的下⼀幀恢復，但也可以使⽤ 
WaitForSeconds 採⽤時間延遲： 



XXXIX.協程 Coroutine（⼆） 
Coroutine 可以⽤於在⼀段時間內傳播效果的⼀種⽅式，⽽它也是種有⽤的
最佳化。遊戲中的許多任務需要定期執⾏，最常⾒的⽅法是將它們包含在 
Update 功能中。然⽽，這個功能通常會每秒呼叫多次。當任務不需要如此
頻繁地重複時，可以將其放在 Coroutine 中以定期更新，⽽不是每⼀幀。這
樣的例⼦可能是⼀個警告，如果敵⼈在附近，則警告玩家。程式碼可能如下
所⽰： 

如果有很多敵⼈，那麼每⼀幀都要呼叫這個功能可能會有很⼤的效能開銷。
但是，你可以使⽤ Coroutine 每⼗分之⼀秒才呼叫⼀次。 

這將⼤⼤減少執⾏的檢查次數，⽽對遊戲沒有任何明顯的影響。 



以下是完整的範例程式碼： 

注意：當 MonoBehaviour 被停⽤時，Coroutine 不會被停⽌，⽽只能明確
地將它銷毀。你可以使⽤ MonoBehaviour.StopCoroutine 和 
MonoBehaviour.StopAllCoroutines 來停⽌ Coroutine。當 MonoBehaviour 
被銷毀時，Coroutine 也會被停⽌。 



XL.命名空間的使⽤ 
隨著專案越來越⼤，腳本數量的增加，腳本 Class 名稱之間發⽣衝突的可能
性也越來越⼤。尤其是當幾個程式⼈員分別在遊戲的不同⽅⾯進⾏⼯作時，
最終會將他們的⼯作合併到⼀個專案中。例如，⼀個程式⼈員可能正在編寫
程式碼來控制主要玩家角⾊，⽽另⼀個程式⼈員也在編寫敵⼈的同等效果的
程式碼。兩個程式⼈員都可以選擇稱他們的主要腳本 Class 名稱為 
Controller，但是當它們在專案合併時，將會發⽣衝突。 

在某種程度上，通過採⽤命名約定或者發現衝突時重新命名 Class 可以避免
這個問題（例如，上⾯的 Class 可以給出像 PlayerController 和 
EnemyController 這樣的名字）。然⽽，當有好幾個 Class 有衝突的名稱或
使⽤這些名稱聲明變數時，這很麻煩，每個提到的舊 Class 名稱都必須要替
換程式碼來編譯。 

C# 語⾔提供了⼀個稱為命名空間的功能，以⼀種可靠的⽅式解決這個問題。
命名空間只是個被參考的 Class 集合，以在 Class 名稱之上使⽤⼀個被選定
的前綴。在下⾯的例⼦中，名為 Player 和 Enemy 的命名空間分別都有名為 
Controller 的成員： 



在程式碼中，這些 Class 分別被稱為 Player.Controller 和 
Enemy.Controller。這比重新命名 Class 更好，因為命名空間可以圍繞現有
的 Class 進⾏括號（即，不必單獨更改所有 Class 的名稱）。此外，即使相
同命名空間的 Class 在不同的檔案中，你也可以在 Class 的任何位置使⽤括
號中的命名空間部分。 

可以在檔案頂部添加 using 指令來避免重複輸入命名空間前綴。 

如果腳本還需要從不同的命名空間引⽤具有相同名稱的 Class，那麼仍然要
使⽤前綴。如果 using 指令同時導入包含衝突 Class 名稱的兩個命名空間，
則編譯器仍將報錯。 



XLI.屬性的使⽤ 
屬性（Attribute）是可以放置在腳本中的 Class、特性（Property）或函數
上⽅的標記，以指⽰特殊⾏為。例如，HideInInspector 屬性可以添加到欄
位變數聲明之上，以防⽌其在 Inspector 視窗中顯⽰，即使它是公開的。在
C＃中，它包含在中括號內： 

Unity 提供的腳本參考中列出了許多屬性可使⽤。還有在 .NET 庫中定義的
屬性，有時在 Unity 程式碼中也會有⽤。 



XLII.了解⾃動記憶體管理 
當創建物件，字串或陣列時，記憶體會被要求從稱為堆（Heap）的中央池
分配來儲存它們。當該項⽬不再使⽤時，它曾經佔⽤的記憶體可以被回收並
⽤於其他的東西。在過去，通常由程式⼈員通過適當的函數調⽤明確分配和
釋放這些堆記憶體塊。 如今，像 Unity 的 Mono 引擎這樣的執⾏期系統會
⾃動為你管理記憶體。⾃動記憶體管理需要比明確的分配/釋放更少的程式
編寫⼯作，並⼤⼤減少記憶體洩漏的可能性（記憶體被分配但從未隨後釋放
的情況）。 

1. 實值與參考類型 Value and Reference 
Types 
當呼叫函數時，會將其參數的值複製到為該特定呼叫保留的記憶體區域。只佔⽤
幾個 Byte 的資料類型可以非常快速容易地複製。然⽽，通常物件，字串和陣列

會⼤得多，如果這些類型的資料被頻繁的複製，效率會非常低。所幸，這不是必
需的︔從堆中分配⼤項⽬的實際儲存空間，並使⽤⼩的「指針（pointer）」值
來記住其位置。從此，在參數傳遞過程中只需要複製指針。只要執⾏期系統可以

定位由指針標識的項⽬，資料的單⼀副本就可以如往常所需要的來使⽤。 

在參數傳遞期間直接儲存和複製的類型稱為實值類型。這些包括整數、浮點數、

布林值和 Unity 的結構物件（例如 Color 和 Vector3）。分配在堆上然後通過指
針訪問的類型稱為參考類型，因為儲存在變數中的值僅僅是「參考」到實際資料。
參考類型包括類物件、字串和陣列。 

2. 分配與垃圾回收 Allocation and 
Garbage Collection 
記憶體管理器保持追踪它所知道未被使⽤的堆中的區域。當請求新的記憶體塊時
（例如，當物件被實例化時），管理器從所選擇的未使⽤區域來分配記憶體塊，

然後從已知的未使⽤空間中移除被分配的記憶體。連串的請求以相同⽅式處理，
直到沒有⾜夠⼤的⾃由空閒區域來分配所需的塊⼤⼩。在這⼀點上，從堆中分配
的所有記憶體都仍然在使⽤中是非常不可能的。⼀個在堆上的參考項⽬只要仍然

有參考變數可以定位它就可以被訪問到。如果對記憶體塊的所有參考都消失了



（即，參考變數已被重新分配，或者它們現在是超出範圍的區域變數），那麼它
佔⽤的記憶體就可以安全地被重新分配。 

要確定哪些堆塊不再使⽤，記憶管理器將搜索所有當前活動的參考變數，並將其
標識為「活的」。在搜索結束時，被記憶體管理器認定活的塊之間的任何空間是
空的，就會被⽤於後續的分配。顯⽽易⾒的，找出並釋放未使⽤的記憶體的過程

稱為垃圾回收（或簡稱GC）。 

3. 最佳化 Optimization 
垃圾回收對於程式⼈員來說是⾃動且看不⾒的，但回收過程實際上需要在背後花

費⼤量的 CPU 時間。正確使⽤時，⾃動記憶體管理普遍會均等分配整體效能。
但是，對於程式⼈員來說，重要的是要避免過多觸發回收器⽽導致執⾏暫停的錯
誤。 

有⼀些臭名昭著的算法會是 GC 惡夢，即使它們看起來沒什麼。重複的字串連接
是個典型的例⼦： 

這裡的關鍵細節是，新的⽚段不會被逐個添加到字串中。實際發⽣的是，每次循
環時，line 變數的先前內容都將變為無效的 - ⼀個全新的字串被分配以包含原始

的部分加上最後的部分。由於字串隨著 i 的增加值⽽變長，所以佔⽤的堆空間量
也會增加，因此每次呼叫該函數時，都容易的就使⽤上百個 Byte 的堆空間。如
果你需要連接多個字串，那麼⼀個更好的選擇是 Mono 庫的 

System.Text.StringBuilder 類。 



然⽽，如果不被頻繁的呼叫，即使重複連接也不會引起太多麻煩，⽽在 Unity 中
通常隱含著幀更新。就像是： 

每次呼叫 Update 時都會分配新的字串，並不斷⽣成新垃圾。這⼤多數可以透過
只有當分數改變時的更新⽂字來儲存： 



當函數回傳陣列值時，會發⽣另⼀個潛在的問題： 

當創建⼀個充滿值的新陣列時，這種類型的函數非常優雅和⽅便。但是，如果重
複呼叫，則每次都會分配新的記憶體。由於陣列可能非常⼤，可⽤堆空間可能會

迅速消耗，導致垃圾回收頻繁。避免這個問題的⼀個⽅法是利⽤陣列是參考類型
的事實。做為參數傳遞給函數的陣列可以在該函數內修改，結果將在函數回傳後
保留。像上⾯這樣的功能通常可以被替換為： 

這只是⽤新的值替換陣列的現有內容。雖然這需要在函數程式碼中完成陣列的初
始分配，但是在呼叫該函數時不會產⽣任何新的垃圾。 

4. 請求回收 
如上所述，最好盡量避免分配。但是，鑑於不能完全消除這些問題，你可以使⽤
兩種主要策略來最⼤限度地減少它們對遊戲遊玩的侵擾： 

• 快速頻繁的⼩堆垃圾回收： 

這個策略通常最適合長時間遊玩的遊戲，其中平穩的幀速率是主要的關注點。
這樣的遊戲通常會頻繁地分配⼩塊，但這些塊將僅在短時間內使⽤。在iOS 上

使⽤此策略時，典型的堆⼤⼩約為200KB，iPhone 3G 上的垃圾回收⼤約需
要 5ms。 如果堆增加到1MB，則收集⼤約需要7ms。因此有時可以以規則的



幀間隔請求垃圾回收。這通常會使回收發⽣的次數比絕對必要的更多，但它
們將被快速處理，對遊戲的影響最⼩： 

但是，你應該謹慎使⽤此技術，並檢查 Profiler 統計訊息，以確保它真正減少
了遊戲的回收時間。 

• 緩慢但不常⾒的⼤堆垃圾回收： 

這種策略對於遊戲分配相對不頻繁並且可以在遊戲暫停期間處理的遊戲最適
合。它對於盡可能⼤的堆是有⽤的，對於由於系統記憶體不⾜⽽使你的應⽤

程式被作業系統關掉⽽⾔並不⼤。然⽽，如果可能，Mono 運⾏時會⾃動避免
擴張堆。你可以通過在啟動期間預先分配⼀些佔位符空間來⼿動擴展堆（即，

實例化⼀個純粹為了對記憶體管理器影響分配的「無⽤」物件）： 

⼀個⾜夠⼤的堆不應該在可容納⼀個回收的遊戲進⾏中的暫停期間被完全填
滿。當暫停發⽣時，你可以明確請求回收： 

同樣的，你應該在使⽤此策略時注意並關注 Profiler 統計訊息，⽽不僅僅是假
設它具有預期的效果。 



5. 可重複使⽤的物件池 
在許多情況下，你可以通過減少創建和銷毀的物件數量來避免⽣成垃圾。遊戲中
存在某些類型的物件，例如投射物，儘管只會有⼀⼩部分會⽴刻執⾏，但可能會

⼀再遇到。在這種情況下，通常可以重複使⽤物件⽽不是破壞舊的物件，並將其
替換為新物件。 



XLIII.平台相依編譯與定義 
Unity 包含⼀個名為 Platform Dependent Compilation 的功能。 這包括⼀
些預處理器指令，可以讓你分割腳本來編譯和執⾏專⽤於⼀個受⽀援平台的
程式碼。 

可以在 Unity 編輯器中運⾏此程式碼，因此可以專⾨為你的⽬標平台編譯程
式碼，並在編輯器中進⾏測試！ 

1. 平台定義指令 
Unity ⽀援你腳本的平台定義指令如下： 

• UNITY_EDITOR：⽤於從你的遊戲程式碼呼叫 Unity Editor 腳本。 

• UNITY_EDITOR_WIN：⽤於 Windows 的 Editor 程式碼。 

• UNITY_EDITOR_OSX：⽤於 Mac OS X 的 Editor 程式碼。 

• UNITY_STANDALONE_OSX：⽤於特別提供 Mac OS X（包含 Universal、

PPC 和 Intel 架構）編譯／執⾏程式碼。 

• UNITY_STANDALONE_WIN：⽤於特別提供 Windows 單機應⽤程式編譯

／執⾏程式碼。 

• UNITY_STANDALONE_LINUX：⽤於特別提供 Linux 單機應⽤程式編譯／
執⾏程式碼。 

• UNITY_STANDALONE：⽤於特別提供單機平台（Mac OSX、Windows 或 
Linux）編譯／執⾏程式碼。 

• UNITY_WII：⽤於 Wii 遊戲機編譯／執⾏程式碼。 

• UNITY_IOS：⽤於 iOS 平台編譯／執⾏程式碼。 

• UNITY_ANDROID：⽤於 Android 平台。 

• UNITY_PS4：⽤於運⾏ PlayStation 4 程式碼。 

• UNITY_SAMSUNGTV：⽤於執⾏ Samsung TV 程式碼。 

• UNITY_XBOXONE：⽤於執⾏ Xbox One 程式碼。 



• UNITY_TIZEN：⽤於 Tizen 平台。 

• UNITY_TVOS：⽤於 Apple TV 平台。 

• UNITY_WSA：⽤於通⽤ Windows 平台。另外，NETFX_CORE 是根
據 .NET Core 編譯 C# 檔案並使⽤ .NET 腳本後端定義的。 

• UNITY_WSA_10_0：⽤於通⽤ Windows 平台。 另外 WINDOWS_UWP 是

針對 .NET Core 編譯 C# 檔案時定義的。 

• UNITY_WINRT：等同於 UNITY_WSA。 

• UNITY_WINRT_10_0：等同於 UNITY_WSA_10_0。 

• UNITY_WEBGL：⽤於 WebGL。 

• UNITY_ADS：⽤於從你的遊戲程式碼呼叫 Unity Ads ⽅法。版本 5.2 及以

上。 

• UNITY_ANALYTICS：⽤於從你的遊戲程式碼呼叫 Unity Analytics ⽅法。版

本 5.2 及以上。 

• UNITY_ASSERTIONS：⽤於中斷控制處理。 

從 Unity 2.6.0 起，可以有選擇地編譯程式碼。可⽤的選項取決於你正在編輯的

編輯器版本。給定版本號 X.Y.Z（例如2.6.0），Unity ⽤以下格式公開了三個全
域定義指令：UNITY_X，UNITY_X_Y 和 UNITY_X_Y_Z。 

以下是 Unity 5.0.1 中定義指令的範例： 

• UNITY_5：⽤於發佈版本 Unity 5，包含每個 5.X.Y 版本。 

• UNITY_5_0：⽤於主要版本 Unity 5.0，包含每個 5.0.Z 版本。 

• UNITY_5_0_1：⽤於 Unity 5.0.1 的次要版本。 

從 Unity 5.3.4 開始，你可以根據更早版本的 Unity 所需要編譯或執⾏所給予的

部分程式碼，選擇性的編譯程式碼。給定與上述相同的版本格式（X.Y.Z），
Unity 以格式 UNITY_X_Y_OR_NEWER 顯⽰⼀個全域定義，可以⽤於此⽬
的。 

⽀援的定義指令是： 

• ENABLE_MONO：提供 Mono 的腳本後端。 



• ENABLE_IL2CPP：提供 IL2CPP 的腳本後端。 

• ENABLE_DOTNET：提供 .NET 的腳本後端。 

• NETFX_CORE：在 .NET 上針對 .NET Core 類庫構建腳本時定義。 

• NET_2_0：在 Mono 和 IL2CPP 針對 .NET 2.0 API 相容級構建腳本時定義。 

• NET_2_0_SUBSET：在 Mono 和 IL2CPP 上針對 .NET 2.0 ⼦集 API 相容級

別構建腳本時定義。 

• NET_4_6：在 Mono 和 IL2CPP 針對 .NET 4.6 API 相容級構建腳本時定義。 

• ENABLE_WINMD_SUPPORT：當 Windows Runtime 在 IL2CPP 和 .NET 
上被啟動時定義。 

你可以使⽤ DEVELOPMENT_BUILD 來識別你的腳本是否在啟⽤ Development 

Build 選項構建中運⾏。 

你還可以根據腳本後端選擇性地編譯代碼。 

2. 測試預定義編碼 
以下是如何使⽤預編譯編碼的範例。它列出⼀個取決於你為你的⽬標構建選擇的
平台的訊息。 

⾸先，選擇要測試程式碼的平台，到 File > Build Settings 開啟 Build Settings 視

窗︔從這裡選擇⽬標平台。 



選擇要測試你的預編譯編碼的平台，然後點擊 Switch Platform，告訴 Unity 你
想要要指向的平台。 

使⽤以下程式碼建⽴腳本： 

要測試程式碼，請點擊播放模式。根據你選擇的平台，在 Unity Console 視窗中
檢查相關消息，確認程式碼的⼯作原理 - 例如，如果你選擇 iOS，則會在 

Console 視窗中顯⽰訊息「Iphone」。 

請注意，在 C# 中，可以使⽤⼀個 Conditional 屬性，他是更乾淨、更不容易出
錯的剝離功能的⽅法。 有關詳細信息，請參閱 http://msdn.microsoft.com/en-

us/library/4xssyw96(v=vs.90).aspx。 

 

http://msdn.microsoft.com/en-us/library/4xssyw96(v=vs.90).aspx
http://msdn.microsoft.com/en-us/library/4xssyw96(v=vs.90).aspx


除了基本的 #if 編譯器指令之外，還可以在使⽤多向測試： 



3. 平台⾃定義 
還可以為內建的定義指令提供⾃⼰定義的指令。打開 Player Settings 的 Other 
Settings ⾯板，並找到 Scripting Define Symbols ⽂字欄位。 

輸入要為該特定平台定義的符號名稱，以分號分隔。這些符號可以⽤於 #if 指令
的條件，就像內建的⼀樣。 



XLIV.特殊資料夾與編譯順序 
Unity 保留⼀些專案資料夾名稱，以表明內容具有特殊⽤途。這些資料夾名
稱為： 

• Assets 

• Editor 

• Editor default resources 

• Gizmos 

• Plugins 

• Resources 

• Standard Assets 

• StreamingAssets 

其中⼀些資料夾對腳本編譯的順序有影響。 

腳本編譯有四個不同的階段。編譯腳本的階段由其⽗資料夾決定。 

在腳本必須參考其他腳本中定義的類的情況下，這是很重要的。基本規則是
在當前編譯之後的任何內容都不能被參考到。在當前階段或更早階段編譯的
任何內容都是完全可⽤的。 

當⽤⼀種語⾔編寫的腳本必須參考另⼀種語⾔定義的類（例如，有個 
UnityScript 檔案所聲明變數的類別定義於 C# 腳本中）時，會發⽣另外的情
況。這裡的規則是被參考的類必須在較早的階段被編譯。 

編譯階段如下： 

• 第 1 階段：名為 Standard Assets、Pro Standard Assets 和 Plugins 的資
料夾中的執⾏期腳本。 

• 第 2 階段：位於名為 Standard Assets、Pro Standard Assets 和 Plugins 
的頂級⽂件夾中任何位置的名為 Editor 的資料夾中的編輯器腳本。 



• 第 3 階段：不在名為 Editor 的資料夾內的所有其他腳本。 

• 第 4 階段：所有剩餘的腳本（位於名為 Editor 的資料夾內）。 

當 UnityScript 檔案需要參考 C# 檔案中定義的類時，會發⽣此順序的重要
性的常⾒例⼦。要實現這⼀點，你需要將 C# 檔案放在 Plugins 資料夾中，
將 UnityScript 檔案放在非特殊資料夾中。如果你不這樣做，會出現錯誤指
出找不到 C# 類。 

注意：Standard Assets 僅在 Assets 根資料夾中運作。 



XLV.腳本序列化 
序列化是將資料結構或物件狀態轉換為 Unity 可以在以後儲存和重建的格式
的⾃動過程。Unity 的⼀些內建功能使⽤序列化︔如儲存和載入、Inspector 
視窗、實例化以及 Prefab。 

如何在 Unity 專案中組織資料會影響 Unity 如何序列化資料，並可能對專案
的效能產⽣重⼤影響。以下是 Unity 中序列化的⼀些指導，以及如何最佳化
你的專案。 

1. 了解熱重新載入 
• 熱重新載入 

熱重新載入是編輯器開啟期間創建或編輯腳本並⽴即套⽤腳本⾏為的過程。

你不必為了使改變⽣效⽽重新啟動遊戲或編輯器。 

當你更改並儲存腳本時，Unity 熱重新載入所有當前已載入的腳本資料。它⾸
先儲存所有已載入的腳本中的所有可序列化的變數，並且在載入腳本後，還

原它們。所有不可序列化的資料在熱重新載入後都會丟失。 

• 儲存與載入 

Unity 使⽤序列化從你的電腦硬碟中載入和儲存場景、資源以及 
AssetBundle。這包括被儲存在你⾃⼰的腳本 API 物件中的資料，如 
MonoBehaviour 組件和 ScriptableObject。 

Unity 編輯器中的許多功能構建在核⼼序列化系統之上。使⽤序列化所特別要
注意到的兩個部分是 Inspector 視窗和熱重新載入。 

• Inspector 視窗 

當你在 Inspector 視窗中查看或更改 GameObject 組件欄位的值時，Unity 將
對此資料進⾏序列化，然後將其顯⽰在 Inspector 視窗中。當 Inspector 視窗

顯⽰欄位的值時，不會與 Unity Scripting API 相通。 

如果在腳本中使⽤屬性，則當查看或更改 Inspector 視窗中的值時，任何屬性 

getter 和 setter 都不會被呼叫，因為 Unity 直接序列化了 Inspector 視窗欄 



位。這意味著：雖然 Inspector 視窗中的欄位值代表腳本屬性，但是 
Inspector 視窗中值的更改不會在腳本中呼叫任何屬性 getter 和 setter。 

2. 序列化規則 
Unity 中的序列化器運⾏於即時遊戲環境中。這對效能有重⼤影響。因此，
Unity 中的序列化與其它程式設計環境中的序列化不同。下⾯列出了有關如何在 
Unity 中使⽤序列化的⼀些提⽰。 

• 如何確保腳本中的欄位是序列化的 

確保： 

- 是公開的，或者有 SerializeField 屬性。 

- 不是靜態的。 

- 不是常數。 

- 不是唯讀。 

- 具備可被序列化的欄位類型。 

• 可被序列化的簡單欄位類型 

- 具備 Serializable 屬性的⾃定義非抽象、非泛型類別。 

- 具備 Serializable 屬性的⾃定義結構（Struct）。 

- 參考繼承⾃ UnityEngine.Object 的物件。 

- 原始資料型態（int、float、double、bool、string 等）。 

- Enum 類型。 

- 某些 Unity 內建的類型：Vector2、Vector3、Vector4、Rect、
Quaternion、Matrix4x4、Color、Color32、LayerMask、

AnimationCurvr、Gradient、RectOffset、GUIStyle 等。 

• 可被序列化的欄位類型容器 

- 可被序列化的簡單欄位類型的陣列。 

- 可被序列化的簡單欄位類型的 List<T>。 



注意：Unity 不⽀援多層次類型（多維陣列、不規則陣列和巢狀類型）的序列
化。 

如果要序列化這些，有兩個選項：將巢狀類型包裝在類或結構中，或使⽤序
列化回調 ISerializationCallbackReceiver 來執⾏⾃定義序列化。 

• 如何確保⾃定義類可被序列化 

確保： 

- 具有 Serializable 屬性。 

- 不是抽象類。 

- 不是靜態的。 

- 不是泛型，儘管可能從泛型類繼承。 

3. 序列化器何時可能出現意外︖ 
• 表現像結構的⾃定義類 

使⽤不是繼承⾃ UnityEngine.Object 的⾃定義類，Unity 將它們透過實值來串

聯序列化，與序列化結構的⽅式類似。如果在多個不同的欄位中儲存對⾃定
義類實例的引⽤，則在序列化時它們將成為單獨的物件。然後，當 Unity 反序
列化欄位時，它們會包含具有相同資料的不同物件。 

當你需要使⽤參考序列化複雜物件圖時，請勿讓 Unity ⾃動序列化物件。⽽是
使⽤ ISerializationCallbackReceiver ⼿動序列化它們。這樣可以防⽌ Unity 從

物件參考中創建多個物件。 

這只適⽤於⾃定義類。Unity 將⾃定義類「內聯」序列化，因為它們的資料成
為其使⽤的 MonoBehaviour 或 ScriptableObject 的完整序列化資料的⼀部

分。當欄位參考某個繼承⾃ UnityEngine.Object 的類（例如 public Camera 
myCamera）時，Unity 將序列化實際參考到 Camera 的 

UnityEngine.Object。如果腳本來⾃於 MonoBehaviour 或 ScriptableObject，
這兩個腳本都是從 UnityEngine.Object 繼承的，那麼腳本的實例也是如此。 

• 不⽀援⾃定義類的 null 

考慮在使⽤以下腳本的 MonoBehaviour 反序列化時，需要多少分配。 



預期⼀個分配並不奇怪：Example 物件。預期有兩個分配也是不奇怪的：⼀
個⽤於 Example 物件，⼀個⽤於 Trouble 物件。 

然⽽，Unity 實際上已經有超過⼀千個分配。序列化器不⽀援 null。如果序列
化⼀個物件，並且欄位為空，則 Unity 將實例化該類型的新物件，並將其序列
化。顯然這可能導致無限循環，所以有七層的深度限制。此時，Unity 停⽌序

列化具有⾃定義類、結構、列表或陣列類型的欄位。 

由於這麼多 Unity 的⼦系統構建在序列化系統之上，所以 Example 

MonoBehaviour 的這個意想不到的⼤型序列化流，使所有這些⼦系統的運⾏
速度較慢。 

• 不⽀援多型 

如果你有個 public Animal[] animals，並且在序列化後，將狗、貓和長頸鹿的
實例放在⼀起，將有三個 Animal 實例。 

處理這個限制來實現的⼀種⽅法是只適⽤於被內聯序列化的⾃定義類。參考
到其他 UnityEngine.Object 得到的被序列化做為實際參考，對於那些，多型
確實有效。你將創建⼀個繼承 ScriptableObject 的類或另⼀個繼承 

MonoBehaviour 的類，並參考它。這樣做的缺點是你需要將 Monobehaviour 
或 ScriptableObject 的物件存儲在某處，並且無法有效地將其序列化。 

這些限制的原因是序列化系統的核⼼基礎之⼀是提前知道物件的資料流佈局：
它取決於類的欄位類型，⽽不是欄位中儲存的內容。 



4. 改善序列化的使⽤ 
你可以組織資料，以確保你從 Unity 的序列化獲得最佳使⽤。 

• 組織你的資料，⽬的是讓 Unity 序列化最⼩的資料集。 這樣做的主要⽬的不

是為了節省電腦硬碟空間，⽽是要確保與以前版本的專案保持向後相容。 如
果你使⽤⼤量的序列化資料，向後相容性在後續的開發中變得更加困難。 

• 組織你的資料，從不將 Unity 序列化為副本資料或快取資料。這會導致向後相

容性的重⼤問題：它具有⾼風險的錯誤，因為資料太容易失去同步。 

• 在你參考其他類的地⽅，避免巢狀、遞歸結構。序列化結構的佈局總是需要

相同︔資料的獨⽴，僅依賴於腳本中暴露的內容。參考其他物件的唯⼀⽅法
是透過從 UnityEngine.Object 繼承的類。 這些類是完全分開的︔他們只是互
相參考，不嵌入內容。 

5. 使編輯器程式碼可熱重載 
當重新載入腳本時，Unity 將所有被載入的腳本中的所有變數序列化並儲存。重
新載入腳本後，Unity 將其恢復為原始的預序列化值。 

當重新載入腳本時，即使變數沒有 SerializeField 屬性，Unity 也會恢復滿⾜序
列化要求的所有變數（包括私有變數）。在某些情況下，你特別需要防⽌修復私
有變數：例如，如果你希望在從腳本重新載入後參考為 null。 在這種情況下，

請使⽤ NonSerializable 屬性。 

Unity不會恢復靜態變數，所以不要在重新載入腳本後需要保留的狀態使⽤靜態

變數。 

6. ⾃定義序列化 
序列化是將資料結構或物件狀態轉換為 Unity 可以在之後儲存和重建的格式的⾃
動處理。 

有時你可能想序列化 Unity 的序列化器不⽀援的東西。在許多情況下，最好的⽅
法是使⽤序列化回調（Callback）。 

序列化回調允許你在序列化器從欄位讀取資料之前以及在寫入完畢之後通知它們。
當你實際序列化時，可以使⽤序列化回調在運⾏時為你的難以序列化的資料提供
不同的表⽰形式。 



要做到這⼀點，要在 Unity 序列化之前，將你的資料轉換成 Unity 所理解的東西。
然後，在 Unity 將資料寫入你的欄位之後，可以將序列化格式轉換為你想要在運

⾏時具有資料格式。 

例如：你想要有個樹資料結構。如果讓 Unity 直接序列化資料結構，那麼「不⽀
持 null」的限制會導致資料流變得非常⼤，導致許多系統的效能下降。如下所

⽰： 



相反，告訴 Unity 不要直接序列化樹，並且製作⼀個單獨的欄位以適合 Unity 序
列化器的序列化格式來儲存樹。如下所⽰： 



 



 



XLVI.UnityEvent 欄位的應⽤ 
UnityEvent 是⼀種允許使⽤者從編輯期持續到執⾏期驅動回調的⽅式，⽽
不需要額外的程式編寫和腳本配置。 

UnityEvent 對於⼀些事情很有⽤： 

• 內容驅動回調 

• 去耦系統 

• 持續回調 

• 預配置的呼叫事件 

UnityEvent 可以添加到任何 MonoBehaviour，並從程式碼裡像標準的 .net 
委派那樣執⾏。當 UnityEvent 添加到 MonoBehaviour 時，它會顯⽰在 
Inspector 視窗中，並且可以添加持續回調。 

UnityEvent 對標準委派具有類似的限制。也就是說，它們保持對⽬標元素
的引⽤，並且停⽌⽬標被垃圾回收。如果你有⼀個 UnityEngine.Object 作
為⽬標，⽽本體表⽰消失，回調則不會被調⽤。 

1. 使⽤ UnityEvent 
要在編輯器中配置回調，需要執⾏以下幾個步驟： 

(1) 確保你的腳本有使⽤ UnityEngine.Events。 

(2)選擇加號（＋）圖標添加回調的插槽。 

(3)選擇你希望接收回調的 UnityEngine.Object（可以使⽤物件選擇器）。 

(4)選擇你要呼叫的功能。 

(5) 你可以為事件添加多個回調。 

在 Inspector 視窗中配置 UnityEvent 時，有兩種類型的函數呼叫被⽀持： 



• 靜態：靜態呼叫是預配置的呼叫，具有在 UI 中設置的預配置值。這意味著當
回調被調⽤時，⽬標函數使⽤已經被輸入到 UI 中的參數來調⽤。 

• 動態：動態呼叫使⽤從程式碼中發送的參數來調⽤，並將其綁定到正在調⽤
的 UnityEvent 類型。UI 過濾回調，並只顯⽰對 UnityEvent 有效的動態呼
叫。 

2. 泛⽤ UnityEvent 
預設情況下，MonoBehaviour 中的 UnityEvent 動態綁定到⼀個 void 函數。這
不⼀定是這種情況，因為 UnityEvent 的動態調⽤⽀持綁定到最多 4 個參數的函

數。為此，你需要定義⼀個⽀持多個參數的⾃定義 UnityEvent 類。這很容易做
到： 

透過將這個實例添加到你的類取代基本的 UnityEvent，它將允許回調動態綁定
到字串函數。 

這可以通過使⽤字串作為參數呼叫 Invoke() 函數來調⽤。 

UnityEvent 可以使⽤在它們的泛型定義中的最多 4 個參數來定義。 



3. UnityEvent 功能 
• Invoke：調⽤所有執⾏時或編輯時所註冊的回調。 

• AddListener：添加監聽器給 UnityEvent，使⽤它來添加運⾏時的回調。 

• RemoveListener：從 UnityEvent 移除監聽器，使⽤它來移除運⾏時的回
調。 



4. UnityEventBase 功能 
• GetPersistentEventCount：取得於 Inspector 視窗上註冊的持續監聽器的數
量。 

• GetPersistentMethodName：使⽤索引取得 Inspector 視窗上註冊的持續監
聽器的⽬標功能名稱。 

• GetPersistentTarget：使⽤索引取得 Inspector 視窗上註冊的持續監聽器的⽬

標組件。 

• RemoveAllListeners：從事件中移除所有非持續監聽器（從腳本創建），所
有的持續監聽器（從 Inspector 視窗創建）不受影響。 





XLVII.Null 參考例外 
當你嘗試訪問未參考任何物件的參考變數，會發⽣ NullReferenceException 
異常。如果參考變數未參考物件，那麼它將被視為 null。運⾏時會告訴你，
你正在嘗試訪問⼀個物件，此時變數為 null，發出⼀個 
NullReferenceException。 

C# 和 JavaScript 中的參考變數在概念上與 C 和 C++ 中的指針相似。參考
類型預設為 null，表⽰它們未參考任何物件。因此，如果你嘗試訪問被參考
的物件，並且沒有⼀個物件可供訪問，則會得到 NullReferenceException。 

當你的程式碼中出現 NullReferenceException 時，這意味著你在使⽤該程
式碼之前忘記了設置變數。錯誤消息將如下所⽰： 

NullReferenceException: Object reference not set to an instance of an object at 
Example.Start () [0x0000b] in /Unity/projects/nre/Assets/Example.cs:10 

此錯誤訊息表⽰ NullReferenceException 發⽣在腳本檔案 Example.cs 的第 
10 ⾏。此外，該訊息表⽰異常發⽣在 Start() 函數內。這使得 Null 
Reference Exception 易於查找和修復。在這個例⼦中，程式碼是： 

程式碼只是尋找⼀個名為「wibble」的遊戲物件。在這個例⼦中，沒有該名
稱的遊戲物件，所以 Find() 函數返回 null。 在下⼀⾏中，我們使⽤ go 變
數，並嘗試列印出參考的遊戲物件的名稱。 因為我們正在訪問不存在的遊
戲物件，所以運⾏時給我們⼀個 NullReferenceException。 



1. Null 檢查 
雖然這種情況可能令⼈沮喪，但這只是意味著腳本需要更加⼩⼼。在這個簡單的
例⼦中的解決⽅案是改變這樣的程式碼： 

現在，在我們嘗試使⽤ go 變數執⾏任何操作之前，我們檢查它不是 null。如果
它是 null，則顯⽰⼀條訊息。 

2. Try／Catch 區塊 
另⼀個導致 NullReferenceException 的原因是使⽤的變數應該在 Inspector 中初
始化。如果你忘記這樣做，那麼變數將為 null。處理 NullReferenceException 
的另⼀種⽅法是使⽤ try / catch 區塊。例如，這段程式碼： 



在此程式碼範例中，名為 myLight 的變數是應在 Inspector 視窗中設置的 
Light。如果未設置此變數，那麼它將預設為 null。嘗試更改 try 區塊中的光的顏

⾊會導致 UnassignedReferenceException 透過 catch 區塊被拾取。catch 區塊顯
⽰⼀個可能對美術和遊戲設計師更有幫助的訊息，並提醒他們在 Inspector 中設
置燈光。 

3. 總結 
• 當你的腳本程式碼嘗試使⽤未設置（參考）和不是物件的變數時，

NullReferenceException 會發⽣。 

• 出現的錯誤訊息告訴你很多關於問題發⽣在程式碼中的何處。 

• 可以通過編寫在訪問物件之前檢查 null 的程式碼來避免 
NullReferenceException，或者使⽤ try / catch 區塊。 



XLVIII.了解向量計算（⼀） 
向量計算是 3D 圖學、物理和動畫的基礎，深入了解它可以充分利⽤ 
Unity。以下是主要操作的描述和關於它們可以使⽤的許多事情的⼀些建
議。 

1. 加法 
當兩個向量相加在⼀起時，結果相當於將原始向量「逐步」⼀個接⼀個相加。請
注意，兩個參數的順序並不重要，因為結果是⼀樣的。 

如果第⼀個向量做為空間中的⼀個點，那麼第⼆個向量可以被解釋為與該位置的
偏移或「跳躍」。例如，要在地⾯之上找到⼀個 5 單位的點，你可以使⽤以下計

算： 

如果此向量代表⼒量，那麼使⽤它們的⽅向和⼤⼩（表⽰⼒量的⼤⼩）⽅⾯考慮
它們是更直覺的。相加兩個⼒量向量會產⽣⼀個相當於⼒量組合的新向量。當使

⽤幾個單獨的組件⼀次作⽤的⼒（例如，向前推進的⽕箭也可能受側風影響）時，
這個概念通常是有⽤的。 

2. 減法 
向量相減最常⽤於獲取從⼀個物件到另⼀個物件的⽅向和距離。請注意，兩個參

數的順序與減法無關： 



與數字⼀樣，加上向量的負數與減去正數相同。 

向量的負數與原始點並沿相同直線相反的⽅向具有相同的⼤⼩。 

3. 純量乘法和除法 
 當討論向量時，通常將普通數值（例如，浮點值）稱為純量。其含義是純量只

具有⼤⼩，⽽向量具有⼤⼩和⽅向。 

將⼀個向量乘以⼀個純量，得到⼀個與原始⽅向相同⽅向的向量。 然⽽，新向
量的⼤⼩等於原始⼤⼩乘以純量值。 

同樣，純量除法將原始向量的⼤⼩除以純量。 

當向量代表運動偏移量或⼒量時，這些操作很有⽤。它們讓你能夠改變向量的⼤

⼩⽽不影響其⽅向。 

當任何向量除以其⾃身的⼤⼩時，結果是⼤⼩為 1 的向量，其被稱為歸⼀化
（Normalized）向量。如果歸⼀化向量乘以純量，則結果的⼤⼩將等於該純量

值。當⼒量的⽅向是恆定的但強度是可控的（例如，來⾃汽⾞的⾞輪的⼒量總是
向前推，但是動⼒由駕駛員控制）時，這是有⽤的。 

4. 點積 
點積取⽤兩個向量並返回⼀個純量。該純量等於兩個向量的⼤⼩相乘，其結果乘
以向量之間角度的餘弦。當兩個向量被歸⼀化時，餘弦本質上說明了第⼀個向量
在第⼆個的⽅向上延伸多遠（反之亦然 - 參數的順序並不重要）。 



⽤角度來思考，然後使⽤計算機找到相應的餘弦是很容易的。然⽽，直覺地了解
⼀些主餘弦值是有⽤的，如下圖所⽰： 

點積是⼀種非常簡單的操作，可以在某些情況下使⽤向量⼤⼩操作代替 
Mathf.Cos 函數（它不完全相同，但有時效果是相同的）。然⽽，計算點積函數

花費的時間要少得多，因此它可以是有價值的優化。 



5. 叉積 
其它操作是針對 2D 和 3D 向量定義的，並且實際上是具有任意⼤⼩的向量。相
比之下，叉積只對 3D 向量有意義。它需要兩個向量作為輸入，並返回另⼀個向

量做為其結果。 

結果向量垂直於兩個輸入向量。「左⼿定則」可⽤於根據輸入向量的順序來控制
輸出向量的⽅向。如果第⼀個參數與⼿的拇指匹配⽽第⼆個參數相對於食指，則

結果將指向中指的⽅向。如果參數的順序相反，則所得到的向量將指向完全相反
的⽅向，但是具有相同的⼤⼩。 

結果的⼤⼩等於輸入向量的⼤⼩相乘在⼀起，然後該值乘以它們之間的角度的正
弦。正弦函數的⼀些有⽤值如下所⽰： 

叉積看起來很複雜，因為它在返回值中結合了幾個有⽤的訊息。然⽽，像點積⼀
樣，它是效率⾼的演算⽅式，可以⽤於改善程式，否則將依賴於緩慢的超越數

（Transcendental）功能。 



6. 從⼀個物件到另⼀個物件的⽅向和距離 
如果從空間中的⼀個點減去另⼀個點，那麼結果就是從⼀個物件「對」到另⼀個
物件的向量： 

除了指向⽬標物件的⽅向之外，該向量的⼤⼩等於兩個位置之間的距離。通常需
要⼀個歸⼀化的向量，給出⽬標的⽅向以及⽬標的距離（比如說⽤於引導射彈）。

物體之間的距離等於指向向量的⼤⼩，該向量可以通過將其除以其⼤⼩來進⾏歸
⼀化： 

這種⽅法優於分別使⽤ magnitude 和 normalized 屬性，因為它們都會讓 CPU 
相當忙碌（它們都涉及計算平⽅根）。 



如果只需要使⽤距離進⾏比較（針對接近檢查），則可以避免 magnitude 計算。
sqrMagnitude 屬性提供 magnitude 的平⽅，並且像 magnitude ⼀樣計算，但沒

有耗時的平⽅根操作。你可以針對平⽅距離來比較平⽅⼤⼩，⽽不是針對已知距
離比較⼤⼩： 

這比使⽤真實⼤⼩進⾏比較更有效率。 

有時，所需要得⽬標點需要在地⾯。例如，想像⼀個站在地上的玩家需要接近浮

在空中的⽬標。如果你從⽬標位置減去玩家的位置，則所得到的向量將向上朝向
⽬標。這不適合於定位玩家的 Transform，因為它們也將向上指向︔真正需要的
是從玩家的位置到⽬標的正下⽅的位置的向量。通過取減法的結果並將 Y 坐標設

置為零可以很容易地獲得。 

未完，不續.... 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